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Customer Satisfaction 

If you discover physical defects in the 
manuals distributed with a Lisa product 
or in the media on which a software 
product is distributed, Apple will 
replace the documentation or media at 
no charge to you during the 90-day 
period after you purchased the product. 

In addition, if Apple releases a 
corrective update to a software product 
during the 90-day period after you 
purchased the software, Apple will 
replace the applicable diskettes and. 
documentation with the revised version 
at no charge to you during the six 
months after the date of purchase. 

In some countries the replacement 
period may be different; check with 
your authorized Lisa dealer. Return any 
item to be replaced with proof of 
purchase to Apple or to an authorized 
Lisa dealer. 

Limitation on Warranties and Liability 

All implied warranties con~er,:,ing ~his 
manual and media, including Implied 
warranties of merchantability and 
fitness for a particular purpose, are 
limited in duration to ninety (90) days 
from the date of original retail 
purchase of this product. 

Even though Apple has tested the 
software described in this manual and 
reviewed its contents, neither Apple 
nor its software suppliers make any 
warranty or representation, either 
express or implied, with respect to 
the software described in this manual, 

©1983 by Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, California 95014 
(408) 996-1010 

its quality, performance, 
merchantability, or fitness for any 
particular purpose. As a result, this 
software is sold "as is," and you the 
purchaser are assuming the entire 
risk as to its quality and performance. 

In no event will Apple or its software 
suppliers be liable for direct, indir.ect, 
special, incidental, or consequential. 
damages resulting from any defect In 

the software or manual, even if they 
have been advised of the possibility of 
such damages. In particular, they shall 
have no liability for any programs or 
data stored in or used with Apple 
products, including the costs of 
recovering or reproducing these 
programs or data. 

The warranty and remedies set forth 
above are exclusive and in lieu of all 
others, oral or written, express or 
implied. No Apple dealer, agent, or 
employee is authorized to make any 
modification, extension, or addition to 
this warranty. 

Some states do not allow the exclusion 
or limitation of implied warranties or 
liability for incidental or consequential 
damages, so the above limitation ~r 
exclusion may not apply to you. This 
warranty gives you specific legal rights, 
and you may also have other rights that 
vary from state to state. 

License and Copyright 

This manual and the software 
(computer programs) described in, it are 
copyrighted by Apple or by Apple s 
software suppliers, with all rights 
reserved, and they are covered by the 

Lisa Software License Agreement 
signed by each Lisa owner. Under the 
copyright laws and the License 
Agreement, this manual or the 
programs may not be copied, in whole 
or in part, without the written consent of 
Apple, except in the normal use of the 
software or to make a backup copy. 
This exception does not allow copies to 
be made for others, whether or not 
sold, but all of the material purchased 
(with all backup copies) may be sold, 
given, or loaned to other persons if they 
agree to be bound by the provisions of 
the License Agreement. Copying 
includes translating into another 
language or format. 

You may use the software on any 
computer owned by you, but extra 
copies cannot be made for this 
purpose. For some products, a multi
use license may be purchased to allow 
the software to be used on more than 
one computer owned by the purchaser, 
including a shared-disk system. 
(Contact your authorized Lisa dealer for 
information on multiuse licenses.) 

Product Revisions 

Unless you have purchased the product 
update service available through your 
authorized Lisa dealer, Apple cannot 
guarantee that you will receive notice. of 
a revision to the software descrl bed In 

this manual, even if you have returned a 
registration card received with the 
oroduct. You should check periodically 
~ith your authorized Lisa dealer. 

Apple, Lisa, and the Apple logo are trademarks of Apple Computer, Inc. 
Simultaneously published in the USA and Canada. 

Reorder Apple Product #A6L0146 



Guide to Lisa Manuals 

Set up your Lisa following the setup procedures in the 
Lisa accessories box or in Appendix 1, Setup 
Procedures, in the Lisa Owner's Guide. 

Go through Section A, LisaGuide, in the Lisa Owner's 
Guide, for an introduction to the Lisa. 

If your dealer or service representative did not set your 
system Preferences so that the Lisa knows what external 
devices are attached, follow the instructions in Section 
D, Desktop Manager Reference Guide, under Set, in the 
Lisa Owner's Guide. 

~ Go to Section A, Getting Started, in the manual for each 
office tool that you want to learn, for the essentials of 
using that tool. 

Go to Section B, Lisa Fundamentals, in the Lisa Owner's 
Guide, for the background information you need before 
beginning long-term work on the Lisa. 

You are now ready to start doing your own work on the 
Lisa: 
• If you want self-paced instructions for using a tool, go 

to Section B, Tutorial, in that tool manual. 
• If you want instructions for performing specific tasks 

with a tool, go to Section C, Reference Guide, in that 
tool manual. 

For specific instructions on filing and desktop 
management, go to Section D, Desktop Manager 
Reference Guide, in the Lisa Owner's Guide. 

For more information on the Lisa hardware, tips on 
caring for the Lisa, and suggestions for troubleshooting 
when the system isn't working properly, go to the other 
sections of the Lisa Owner's Guide. 



029-0109-A 

Contents 

Preface 

A. Getting Started with LisaProject 
A quick introduction to the basic skills needed to use 
LisaProject. 

B. LisaProject Tutorial 
Self-paced instructions on LisaProject using examples 
on the Lisa. 

c. LisaProject Reference Guide 
Complete information on LisaProject consisting of an 
overview and step-by-step procedures. 

D. Appendixes 

E.lndex 

. --I • __ v 

--. 



029-0110-A 

Preface 

LisaProject is a project management tool that helps you 
schedule and track projects. You enter the information 
as individual tasks, and LisaProject shows you the 
critical path, the interdependencies, and the answers to 
What if? questions. LisaProject displays the project as a 
schedule chart, a resource chart, and a task chart. 

This manual contains three kinds of documentation of 
LisaProject: 

• Section A, Getting Started with LisaProject, is a quick 
introduction to the tool. It is designed to give you the 
basic skills for using LisaProject. 

• Section B, LisaProject Tutorial, is a step-by-step guide 
to the major features of LisaProject. It includes 
suggestions on how to use LisaProject efficiently and 
effectively. 

• Section C, LisaProject Reference Guide, is a complete 
reference section. It contains instructions for 
performing specific tasks, including the details of how 
each feature works. 

The material in this manual assumes that you have used 
LisaGuide, which teaches you the fundamentals of using 
the Lisa. The LisaGuide diskette came in the front pocket 
of the Lisa Owner's Guide, and instructions for using it 
appear in Section A of that manual. 

Section B, Lisa Fundamentals, of the Lisa Owner's 
Guide, contains important background information 
about setting up and using the Lisa for long-term work. 
Make sure you understand the concepts in that section 
before going on to either the Tutorial or the Reference 
Guide. Refer to Section D, Desktop Manager Reference 
Guide, of the Lisa Owner's Guide, when you need to 
know how to do filing or how to perform any of the other 
tasks outlined in Section B, Lisa Fundamentals. 

vii 
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The material in this manual can be used in either short or 
long blocks of time. You can complete Getting Started in 
about 30 minutes. Then you can either go through the 
Tutorial one chapter at a time or start creating your own 
documents, looking up procedures in the Reference, 
Guide as you need them. 
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Getting Started 
with LisaProject 

With LisaProject you can plan and track large, complex 
projects, and for anyone project automatically produce a 
Schedule chart, a Resource chart, and a Task chart. 

LisaProject can assist you in managing projects by giving 
you critical scheduling information in a graphic, easy-to
understand form, enabling you to make better decisions 
at the times they're needed. 

Getting Started with LisaProject is a hands-on exercise. 
By going step by step through an easy example, you will 
quickly become familiar with the basic skills for using 
LisaProject, and afterward be able to create, edit, file, 
and print your own LisaProject documents. 

Getting Started ::: A 1 
with LisaProject ••• 



Here's what you need 

What You Need 
to Get Started 

• A Lisa set up and plugged in, with the keyboard and mouse attached. 
• A ProFile set up and plugged in, with the Office System and LisaProject tool on it. 
• A Printer set up and plugged in if you want to print. Make sure your printer is hooked 

up to your Lisa and turned on. Printing is optional. 
• About 30 minutes. 

Note: If your system is not already set up and configured, refer to the Lisa Owner's 
Guide, Appendix 1, Set up Procedures. 

ProFile 

Lisa 

Keyboard 

Mouse 

... A21 : : : Section A 



If you haven't yet gone through LisaGuide, in which Lisa introduces Lisa, now is a good 
time to do so - it will make Getting Started even easier. For instructions on starting 
LisaGuide, refer to the Lisa Owner's Guide, Section A, LisaGuide. 

If you've already gone through a Getting Started for another Lisa tool, you'll see many 
similarities in using LisaProject - the basic concepts for using each Lisa tool are the 
same. 

Getting Started ::: I A3 
with LisaProject ••• 



Starting Up 

What You're About To Do 

Follow the numbered steps below and on the next page to: 

• Turn on and start up your ProFile and Lisa . 
• Learn how to brighten the screen if it has dimmed automatically. 

Note: If your ProFile and Lisa are already on, skip to step 3. The red ProFile light is lit 
when the ProFile is on, and the Lisa on-off button is lit when the Lisa is on. 

Do This 

1 Turn on your ProFile by 
pressing the on-off switch 
on the back, left-hand 
side of the ProFile, as 
shown. 

2 Turn on your Lisa by 
pressing the on-off 
button, at the lower, right
hand side of the Lisa, as 
shown. 

... A41 : : : Section A 



Do This 

3 After several minutes, 
when the red ProFile light 
stops flashing, your 
screen should look 
something like the one to 
the right. (See something 
different? Refer to the 
Lisa Owner's Guide, 
Section G, 
Troubleshooting.) 

4 If your Lisa has been on 
for a period of time with 
no activity, the screen 
may have automatically 
dimmed. If your screen is 
dim, just move the mouse 
to brighten it. 

Getting Started 
with LisaProject · · ·IA5 ... ... 



The Desktop and the Mouse 

What You're About To Do 

The gray area of your screen is called the desktop. Like the desktop of an office desk, 
it's where you do your work. 

The mouse is what you use to communicate with your Lisa - you use it to pOint out 
what it is you want done. 

To get familiar with your Lisa's desktop and how to use the mouse, follow the steps 
below. 

Do This 

1 Hold the mouse as 
shown. (Don't press the 
mouse button yet.) 

... A61 : : : Section A 



Do This 

2 Slide the mouse on your 
desk to move the pointer 
around the Lisa desktop 
- the gray part of your 
screen. 

Notice the menu bar across the 
top of your screen - it contains 
menus of different actions you 
can take. Along the bottom of 
your screen are various icons -
graphic symbols that stand for 
different things. 

3 To get oriented, move the 
pointer to the different 
spots shown to the right. 
(Trouble making the 
pointer go where you 
want it to go? Lift up and 
reposition the mouse.) 

Getting Started A7 
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Seeing What's on a Disk 

What You're About To Do 

To get at the document you'll work with, you first need to open the ProFile disk icon as 
described in the steps below. 

The way you'll open the disk will illustrate your Lisa's most general principle: 

• First you select something . 
• Then you do something to what you've selected. 

Do This 

1 Select (highlight) the 
ProFile disk icon by 
placing the tip of the 
pointer on it and clicking 
the mouse button, as 
shown. (Icon not 
highlighted? Try again.) 

... A81 : : : Section A 



Do This 

2 Open the selected disk 
icon by choosing Open 
"ProFile" from the 
File/Print menu. 

Here's how 
• Press and hold with the 
pointer's tip on File/Print 
in the menu bar . 
• Move the pointer down 
and release when Open 
"ProFile" is highlighted. 
(Is the Open menu item 
dim? You probably 
clicked somewhere else 
on the gray part of the 
screen and deselected 
the ProFile icon. Go back 
to step 1 and make sure 
the ProFile icon is 
selected.) 

3 Notice the window to the 
ProFile that zooms open 
on your Lisa's desktop. 
Your ProFile is like a very 
large file drawer - it's 
where you'll keep most of 
your work. 

~ m 
L1SacalC P3jler LlsaWnte P3jler LlsaPrO,Ject P3jler Lls.aL1St P3jler 

LJ LJ LJ 
L1SaGr3jlh Examples Llsa'r.'nte Examples LlsaPrOJect Examples LlsaL1St Examples 
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Pulling a Document 

What You're About To Do 

Inside the ProFile window you should see several stationery pads and folders. The 
LisaProject Examples folder contains the example you'll be working on here. In the 
steps below, you will: 

• Open the LisaProject Examples folder. 
• Tear off a sheet from the Getting Started stationery pad that's inside the folder. 
• Move the new sheet, or document, to a clear spot in the folder. 
• Give the new document the name Ad Schedule. 
• Open the document. 

Do This 

• To open the LisaProject 
Examples folder: 

1 Select the LisaProject 
Examples folder by 
clicking on it. 

2 Choose Open 
"LisaProject Examples" 
from the File/Print menu. 

Notice the window to the 
LisaProject Examples folder that 
zooms open, and its contents, as 
shown. The "network" patterns 
on the icons in the folder show 
they are LisaProject icons. 

A 10 ::: Section A 
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Do This 

• Copies of the Getting 
Started example are on 
the Getting Started 
stationery pad. To tear off 
a sheet from the pad: 

1 Select the Getting 
Started pad icon. 

2 Choose Tear Off 
Stationery from the 
File/Print menu and wait 
a moment until the new 
document appears, as 
shown . 

• To move the new icon out 
of the way, to a clear spot 
in the folder: 

1 Place the pointer on the 
icon. 

2 Press and hold down the 
mouse button and move 
the icon as shown; then 
release the mouse 
button. 

11111 LlsaProject EX(1mples 111'11 

Chapter 1 Product Design European Dlstnbutlon Construction 

Ilill LlsaProject EX(1mples 111:11 

-~ ~ 
( Gett1l1g Started Chapter 1 

,-~ Jl. 
~-~ 
Job ShOp 

Product DeSign European Dlstnbutlon Constn>:>t1on 
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Do This 

• To rename the new 
document: 

1 Make sure the untitled 
document icon is still 
selected (highlighted). If 
you've deselected the 
icon by clicking 
elsewhere on the screen, 
select it again by clicking 
on it. 

2 Type the name Ad 
Schedule. (Typing 
mistake? Use the 
(Backspace) key to correct 
it.) 

A12 ::: Section A 
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Do This 

• To open the Ad Schedule 
document: 

1 Make sure the document 
icon is selected 
(highlighted). 

2 Choose Open "Ad 
Schedule" from the 
File/Print menu. 

Notice how the icon zooms open 
in to a window. Wait a minute -
the hourglass, ~, means wait -
until the LisaProject tool 
displays the Ad Schedule 
document, as shown. 

File/Print Edit Type Style Page layout Customize Chart 

Ll • I 

8 Switch-On Cornrnuncations, Inc. 
\ 

Ad Production Schedule 

(--\ 
f---------1~ End) 

'---'-----' / ---
...------"',/' 
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The LisaProject Docutnent 

The Ad Schedule document is now open on your Lisa's desktop. 

Across the menu bar at the top of the screen are the LisaProject menu names. Each 
menu contains a list of actions you can take with a LisaProject document. 

The LisaProject Schedule chart is made up of task boxes, milestone circles, and 
connecting lines, called arrows. 

Each task box contains three pieces of information: the name of the task, the name of 
the person responsible for the task, and the estimated number of days to complete the 
task. For example, the resource person responsible for the task labeled "Finalize Ads" 
is named "Pat", and the estimated duration of the task is "10" days. 

Unlike task boxes, milestone circles do not contain resources or durations. A 
milestone typically indicates a major step in the completion of a project. For example, 
"Agreement on Ad Strategy" is a milestone. 

The connecting lines, called arrows, show the dependencies among the tasks and 
milestones, and indicate that the task or milestone on the left must be completed 
before the one on the right can be started. For instance, there must be agreement on 
the ad strategy before ad space can be purchased and ad production can begin. 

... A 141: :: Section A 



Without pressing the mouse button, move the pointer around the screen and notice 
how the shape of the pointer changes to a drawing pointer, +, when it's over a blank 
part of the Schedule chart, to a text pointer, I, when it's over text, and to an arrow 
pOinter, " when it touches the edge of a task box, milestone circle, or arrow. 

Milestone circle Arrows Task box Task label 

LisaProject menu names 
File/Print Edit Type tyle Page l yout Customize Char 

Ll ., ., 
/, 

8 
f¥ 
~ 

Swi ch-On C rnmuncations, I c. 
\ 

Ad Prod tion Schedule 

Design Ads L..., 

.~-----------------

(Agreerlent on 
I Purchase Ad I r\ 

Pat 10 Space 
i EM) \ Ad strategy l~~;;~····~~·····i 

Schedule chart \ /~-~<" / § t::::l 1:'~~~;7~ ................... ~ 

RICI< 7 Pat 20 

~ 

CO 
~le:Jl I2lIQ51 

Resourcel I Duration 
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What You Are Going to Do 

Imagine you work for a fictional company called Switch
On Communications, Inc. You've put together a 
preliminary schedule for an ad production project that 
now needs some editing. You need to add another task 
to the schedule, and because the overall project has an 
aggressive deadline, you also need to shorten the 
duration of some tasks. 

In the next several pages you will learn to: 

1. Display the earliest and latest possible dates that each 
task can be started and finished, and identify those 
tasks that are critical for completing the entire project 
in the shortest possible time. 

2. Draw and enter information into a new task box. 

3. Add the new task box to the schedule. 

4. Ask "What If?" by changing task durations and 
evaluating changes to the schedule. 

5. View the schedule as a Resource chart and a Task 
chart. 



Display dates 

When you are finished, your schedule will look like the 
one below. Compare it with the schedule now on your 
screen. 

Ask "What If?" 

File/Print Edit Type Style 
Ll ., 

View schedule as a 
Resource and Task chart 

e 
2121183 

Switch-On C mmuncations, Inc. 
\ 

2121183 317183 

317183 311M)3 3116183 U/8183 

Add the new task 
box to the schedule 
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Displaying Dates on the 
Project Schedule Chart 

What You're About To Do 

Follow the steps below to display the earliest and latest possible dates that each task 
can be started and finished in order to complete the project in the shortest possible 
time. LisaProject will automatically calculate the dates based on the dependencies 
and durations of each task, and a five day work week. Once the dates are displayed, 
you'll be able to identify the entire project's earliest possible completion date, and the 
project's critical tasks. 

Note: In project scheduling, critical tasks are those tasks that must be completed on 
time if the entire project is to be finished in the earliest possible time. A task that is not 
critical has slack time, extra time in which the task can be completed without affecting 
the project's overall finish date. If you're unfamiliar with project scheduling, this will 
become clearer as you work through this example. 

Do This 

1 Choose Display Dates 
from the Customize menu 
to bring up the Display 
Dates dialog box, as 
shown. 

A18 ::: Section A 

File/Print Edit Type Style Page layout Customize Chart 

( [ancel 

Early Start 0 On • Off Early Finish 0 On • Off 

late start 0 On • Off late Finish 0 On • Off 

Ad Production Schedule 

End 



Do This 

2 Use the mouse to check 
each of the "On" boxes, 
and then check "OK", as 
shown. 

3 Take note of the dates 
now displayed on the 
Schedule chart. The 
"Start" circle shows that 
the whole project is to 
begin 2/21/83. The 
bolded boxes show tasks 
that are critical. A slip of 
one day on a critical task 
will slip the entire project 
one day beyond the 
earliest possible finish 
date of 4/27/83. 

Notice that the task box labeled 

Click in each "On" box 

File/Print 

Early Start 

late Start 

it Type Style 

On 0 OFF 

On 0 OFF 

,--

On 0 OFF 

late Finish • On 0 OFF 

Ad Production Schedule 

~~~~~~n~ ______ ~ 

Click OK 

Earliest date task can be started 
Earliest date task 
can be finished 

File/Print Edit Type Style Page layout (stomi e (hart 

Ll " 

8 
2121/83 

Switch-On Commu ca ons, Inc. 
\ 

2121/83 317m Ad Production S hedul 

3/16183 

2121183 317183 

\ 
3/7183 3/16/83 

(ancel 

"Purchase Ad Space" is not 3/7/83 3/16/83 

bolded - it is not a critical task. 
This is because the ad space will 
be purchased during the same I;J 
time the ads are being produced () 
and finalized. Producing and ~O~[]D •••••••••• _' ••••• II.~~~Q~5J~ 
finalizing the ads will take 30 
days, while purchasing the ad Latest date task can be started 
space will take only 14 days, 
resulting in 16 days of slack time 
available for purchasing ad 
space. 

Latest date task can be finished 
without a slip in the entire project 
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Drawing and Entering 
Information into a 
New Task Box 

What You're About To Do 

Your manager has suggested that you test the ads that are produced before you 
finalize them. Follow the steps below to draw a new task box and then enter the 
appropriate information into it. 

Do This 

1 Draw a new task box 
below and between the 
two task boxes labeled 
"Produce Ads" and 
"Finalize Ads", as shown. 

Here's how 

File/Print Edit Type Style Page Layout Customize [hart 
Ll • I 

e 
2121/83 

Switch-On Communcations, Inc. 
\ 

2121/83 317/83 Ad Production Schedule 

• Place the drawing 
pointer, +, where you 
want the upper-left 
corner of the new box . 
• Hold down the mouse 
button; as you move the 
drawing pointer down 
and to the right, a box ",I 

.......... ~, ..... . 
appears. "[J 
II Re!ease the button ? 0 
when the box is the size ~()~[]~ ••• II •• II •• _ •• _II ••• ~~l5Q~Dl:a. 
shown to the right. (Box 
not the size you want, or 
not in the right spot? 
Select the box by clicking 
on its edge with the arrow 
pointer, ,. Then choose 
Cut from the Edit menu 
and start over.) 

... A20 I : : : Section A 
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Do This 

2 Notice the blinking 
vertical line in the top half 
of the box. It's called an 
insertion point, and 
indicates that you are 
able to enter the task 
label. (Don't see an 
insertion pOint? Click 
once in the top half of the 
box to select an insertion 
point.) 

3 Type the task label Test 
Ads and press the (Tab) 
key. (Typing mistake? Use 
the (Backspace) key to 
correct it.) 

Notice that pressing (Tab) 
moves the insertion point down 
to the resource area of the task 
box. 

4 Now enter the name of 
the person who will test 
the ads: type Kim and 
press (Tab) to move the 
insertion point over to the 
duration area of the task 
box. 

Important: The resource 
and duration area of the 
task box are two separate 
areas. You cannot type in 
the name of the resource 
and then press the (Spacebar) 
to get to the duration area. 
To get to the duration area 
you must either press (Tab) 
after typing in the name of 
the resource, or click with 
the pointer in the duration 
area, the lower, right-hand 
area of the task box. 

3/7183 3115183 

3/7183 3115183 

~ 
U/7183 UI'271S3 

Type Test Ads (Tab) 

~ 
U/7183 UI'27183 

Type Kim (Tab) 
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Do This 

5 Make sure the insertion 
pOint is in the duration 
area of the task box, and 
enter the estimated 
duration of the task in 
days: type 7 and press 
(Tab). 

Notice that since the new task 
box is not connected to any 
other tasks, it's displayed dates 
are not yet adjusted to the rest 
of the schedule. 

... A221 : : : Section A 
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Adding a New Task Box 
to the Schedule 

What You're About To Do 

The ads must be produced before they can be tested, and tested before they can be 
finalized. With these dependencies in mind, connect the new task to the project 
schedule as described in the steps below. 

Do This 

1 Draw a connecting line, 
or arrow, from the 
"Produce Ads" task box 
to the "Test Ads" task 
box, as shown. 

Here's how 
• Place the pointer in the 
middle of the "Produce 
Ads" task box. 
• Hold down the mouse 
button and move the 
pointer to the middle of 
the "Test Ads" task box; 
then release. 

Notice the new connecting arrow 
and the change in displayed 
dates. 

File/Print Edit Type Style Page Layout Customize [hart 

Ll 
<} 

e::J e 
2/21/83 

Switch-On Communcations, Inc. 
\ 

2/21/83 317/83 

2/21/83 317/83 

\ 
317/83 3/16/83 

Ad Production Schedule 

3/16/83 

3/16/83 

Press here 
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Do This 

2 Follow the same 
procedure to draw an 
arrow from the "Test 
Ads" task box to the 
"Finalize Ads" task box, 
as shown. 

Notice how the displayed dates 
are recalculated for the "Finalize 
Ads" task box, and that now the 
scheduled end date for the 
project ;s 5/6/83. 

3 Now that you've added 
the "Test Ads" task box 
to the schedule, you can 
cut the arrow between the 
"Produce Ads" task box 
and the "Finalize Ads" 
task box. 

Here's how 
• Select the connecting 
arrow by clicking on it 
with the tip of the arrow 
pointer, ,. (Arrow 
between the tasks not 
highlighted? Try again.) 
• Choose Cut from the 
Edit menu. 

... A241 : : : Section A 
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"What If?": Changing 
Task Durations 
and Evaluating Changes 
to the Schedule 

What You're About To Do 

Besides suggesting that you test your ads before they are finalized, your manager has 
specified that the entire project must be finished by the end of April. But the project is 
now scheduled to end on 5/6/83. 

You've talked to the project team members, and think the time it takes to produce and 
finalize the ads can be reduced. Follow the steps below to see what will happen to your 
schedule when you replace some of the current task durations with your new 
estimates. 

Do This 

1 Select (highlight) the 
number "20" in the 
"Produce Ads" task box, 
as shown. 

Here's how 
• Place the text pOinter, 
I, immediately before 
the "2" . 
• Hold down the mouse 
button and move the 
pOinter through to the 
other side of the "0"; 
then release. (The 
number "20" not 
highlighted? Try again. 
Make sure you start with 
the text pointer just to 
the left of the "2".) 
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Do This 

2 Type 17 and press (Tab). 

Notice that the displayed dates 
are recalculated after you press 
(Tab), and that the project's new 
scheduled end date is 5/3/83, 
still not at your goal. 

3 Follow the same 
procedure in steps 1 and 
2 to reduce the duration 
in the "Finalize Ads" task 
box from "10" to "8", as 
shown. {Select the 
number" 10", type 8, and 
press (Tab).) 

Notice that the displayed dates 
are recalculated after you press 
(Tab), and that your project is 
now scheduled to be completed 
on 4/29/83, finished by the end 
of the month. 
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Viewing the Schedule 
as a Resource Chart 
and a Task Chart 

What You're About To Do 

LisaProject is able to display your project plans in several different ways. Up until now, 
your project has been displayed as a Schedule chart. Take a look at your project 
plotted by resource, and then by task, as described below. 

Do This 

1 Choose Resource from 
the Chart menu to see 
your project schedule laid 
out by resource. The 
Resource chart allows 
you to see the tasks 
performed by each 
resource, and see how 
busy each resource will 
be over the life of the 
project. 

Notice the gray area of the 
"Purchase Ad Space" task bar 
- it shows the slack time for 
that task. If a bar does not show 
slack time, that task is critical. 
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Do This 

2 Choose Task from the 
Chart menu to see your 
project schedule laid out 
by task. The Task chart 
allows you to see the 
overall order in which the 
tasks will be performed. 

3 Choose Schedule from 
the Chart menu to get 
back to your original 
Schedule chart. 

You've examined your 
overall project in various 
ways and you're satisfied 
with the plan. Your 
schedule is now complete. 

Note: The Schedule chart is 
where you actually enter and 
make changes to your project's 
schedule. The Resource and 
Task charts are then generated 
automatically, aI/owing you to 
examine and track your project 
from different vantage points. 
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Printing Your Document 
(Optional) 

What You're About To Do 

If you don't want to print your schedule now, or don't have a printer available, you can 
skip this section and go on to Putting Your Document Away. 

To print a copy of your finished schedule, follow the steps below. 

Do This 

1 To ensure that your work 
is saved on the ProFile 
before you print, choose 
Save & Continue from the 
File/Print menu" 

2 Make sure your printer is 
hooked up and turned on. 
(Refer to the manual that 
came with your printer for 
information on 
connecting the printer 
and loading paper and 
print ribbons.) 
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Do This 

3 Choose Print from the 
File/Print menu to bring 
up the Print dialog box 
shown to the right. (See a 
different message on the 
screen? Go to the next 
page and read the 
"Trouble with printing?" 
section.) 

4 The current settings in 
the Print dialog box are 
fine, so use the mouse to 
check "OK", as shown. 
(Trouble? See "Trouble 
with printing?" on the 
next page.) 

Notice that the hourglass 
appears for a few moments
the hourglass means wait - as 
your Lisa records the 
information necessary to print 
the document. 

5 When your document 
begins printing and you 
see the Monitor the 
Printer dialog box, check 
"Proceed", as shown. 
(Trouble? See "Trouble 
with printing?" on the 
next page.) 

Notice that once the hourglass 
disappears and printing begins, 
you can use your Lisa to do other 
work. 
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Trouble with printing? 

• If you see the alert ~~~~~E~d~it~T~yp~e~S~tY~le~piaige~ljaYioiut~[~u~st~om~i~Ze~[~h~ar~t ======3 
message to the right, Clj·, 0 
refer to the Lisa Owner's eJ 
Guide, Section D, 
Desktop Manager 
Reference Guide, under 
Set Printer Configuration. 

• If you see any other alert 
message, follow its 
instructions. If needed, 
refer to the Lisa Owner's 
Guide, Section G, 
Troubleshooting, under 
Printers, or see the 
manual that came with 
your printer. 

• To learn more about 
printing, refer to Section 
C, LisaProject Reference 
Guide, Chapter 2, under 
Print. 

The document cannot be printed because the 
intended printer does not appear to be 
available. Before you try to print again, 
make sure that your printer is set up the 
way you want and that it is accurately 
described in the Preferences window's 
Device [onnections. 

[oncel 
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Putting Your 
Document Away 

What You're About To Do 

Now that you've finished working on your document, follow the steps below to put it 
away. Even if you chose to print your document and it's still printing, you can continue 
to use your Lisa to do other work. 

Do This 

1 Choose Save & Put Away 
from the File/Print menu. 
(Is the Save & Put Away 
menu item dim? Then you 
need to click in the 
document to make the 
window active.) 

Notice how the window zooms 
down to a document icon back 
in its filing home in the 
LisaProject Examples folder. 
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Starting from Scratch 

What You're About To Do 

In order to start a new schedule, you need to get a piece of LisaProject stationery, as 
described below. Blank LisaProject stationery is in a pad called LisaProject Paper, in 
the ProFile window. 

Do This 

1 Tear off a sheet from the 
LisaProject Paper pad at 
the top of the ProFile 
window. (Select the pad 
icon; choose Tear Off 
Stationery from the 
File/Print menu.) 

2 Don't worry right now 
about moving the untitled 
document out of the way. 
Change the name of the 
untitled document to 
Special Project. (Make 
sure the icon is selected; 
then type.) 
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Do This 
--------------------------------~ .... ---
3 Open the piece of 

LisaProject paper you 
named Special Project as 
you would any document. 
(Choose Open "Special 
Project" from the 
File/Print menu.) 

4 Once the blank piece of 
LisaProject paper 
appears, you are ready to 
begin scheduling a new 
project. Some things you 
should do when creating 
a new project schedule 
are described in the next 
several pages. 
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Creating a New 
Project Schedule 

What You're About To Do 

Anytime you begin a new project schedule, you need to: 

• Give the Schedule chart your own title. 
• Move the "start" and "end" circles apart to give yourself more room to draw task 

boxes. 
• Draw and enter information into the task boxes that all together make up your 

project. 
• Draw connecting arrows between dependent tasks, from left to right. 
• Display the project dates and set a scheduled start date for the project. 

This work flow will be illustrated with a very brief example. The example concerns a 
special project - your vacation. 

Do This 

File/Print Edit Type Style Page Layout Customize Chart 

Ll '" ~IIIII 

• To give the Schedule 
chart the title, "Special 
Project", and the subtitle, 
"My Vacation": 

& 

1 Select the word "Title" by 
pressing and holding with 
the text pOinter just 
before the "T", and then 
moving the pOinter 
across and releasing after 
the "e", as shown. (Didn't 
get it? Just try again.) 

Q .. ,. 
S bTi tl 

Press here Release here 
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Do This 
-------------------------------------------------------------------------- ----
2 Type Special Project. File/Print Edit Type Style Page layout Customize Chart 

Now follow the same Ll 
procedure to replace the 
word "Subtitle" with My 
Vacation, as shown. Special Project 

(Typing mistake? Use the My Vacationl 

(Backspace) key to correct 
it.) 

• To move the "start" and 
"end" circles apart: 

1 Move the tip of the arrow 
pointer to .the edge of the 
"start" circle. Press and 
hold down the mouse 
button, move the circle to 
the left, and then release. 
(Circle didn't move? 
Make sure you press with 
the tip of the arrow 
pOinter on the circle's 
edge.) 

2 Follow the same 
procedure to move the 
"end" circle to the right, 
as shown. (The small 
black quares around the 
circle are called handles; 
they show that the circle 
is selected.) 

Note: You can a/so use this 
procedure to move task boxes. 
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Do This 

• To draw and enter 
information into your task 
boxes: 

1 Draw a task box next to 
the "start" circle, and 
enter the following 
information: Type Buy 
Tickets, (Tab), Your 
N arne, (Tab), 1, (Tab). 

2 Draw another task box to 
the right of the one you 
just drew, and enter this 
information: Type Travel 
Abroad, (Tab), Your 
N arne, (Tab), 30, (Tab). 
(The "30" in this case 
stands for 30 working 
days.) 

• To draw the connecting 
arrows for your project: 

1 Start in the middle of the 
"start" circle and draw a 
connecting arrow to the 
"Buy Tickets" task box. 
Draw the remaining 
arrows as shown, 
remembering to draw 
each arrow from left to 
right. 

c) 
~/ 
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Do This 
--------------------------------------------------------------------------------. .----
• To display the project 

dates for your vacation: 

1 Choose Display Dates 
from the Customize 
menu. When you see the 
Display Dates dialog box, 
check the "On" box for 
just the Early Start and 
Late Finish dates, and 
then check the "OK" 
button so the dates 
displayed look like those 
shown to the right. 

Notice that your vacation's start 
date is shown as 1/3/83, the first 
Monday of the calendar range 
set for this piece of LisaProject 
stationary. 

Note: You can reset the calendar 
range by choosing Calendar 
from the Customize menu . 

• You want your vacation's 
start date to be 7/15/83. 
To set your own 
scheduled start date: 

1 Select the "start" circle 
by clicking on its edge 
with the tip of the arrow 
pointer. (The small black 
squares, called handles, 
show that the circle is 
selected.) 

2 Choose Set Scheduled 
Dates from the Customize 
menu to bring up the 
dialog box shown to the 
right. 
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Do This 

3 The start date in the 
dialog box, "1/1/83", is 
already selected 
(highlighted), so just type 
7/15/83 and check 
"OK". (Typing mistake? 
Use the (Backspace) 

key to correct it.) 

4 Notice the recalculated 
dates and the new date 
now above the "start" 
circle, "7/15/83". The 
underlining of the date 
indicates that you've set a 
scheduled date. 

Note: You can also set 
scheduled dates for other tasks 
and milestones. 

Your Special Project 
schedule is complete. To 
see it without the "start" 
circle selected, click on a 
blank part of the 
Schedule chart. Now if 
you'd like to experiment 
with LisaProject, do so -
try different things. Press 
and move across the 
menu bar and look at 
what's in all your menus. 
If you want specific 
information on 
something, look in the 
LisaProject Reference 
Guide, Section C, or 
check the index. 

Type 7/15/83 
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Finishing Up 

What You're About To Do 

It is a good idea to save all your documents and clear off your Lisa's desktop at least 
once a day. The steps below illustrate one of the many ways you can manage things on 
the Lisa desktop. 

Note:When you are connecting, disconnecting, moving, or servicing equipment, you 
must turn off the power. But normally, you should turn off your Lisa only at the end of 
each week, and always leave your ProFile turned on. 

Do This 

1 Choose Set Aside 
"Special Project" from 
the File/Print menu and 
notice how Special 
Project is set aside as an 
icon on the desktop. 

Note: When you're working with 
several documents at the same 
time, it's often convenient to 
keep some of them set aside on 
the desktop, where it's easy to 
get at them. 

... A40 I : : : Section A 

llsaCalc P>jler 

LJ 
lisacalc Examples 

LJ 

~ 
Gettmg Started 

JOb ShOP 

[{2J ~ 
LIs~r"phP>jler 

LJ LJ 
LIs~r>jlh Examples Lls~Nnte Examples 

LJ 

~ ~ 
Ch>jlter 1 Product DeSign 

~ 
Ad SChedule 

~ 
European DIS tnbutlOn Construction 

f.j1 
~ 

Special Project is Set Aside 



Do This 

2 If you want to file the 
Special Project document 
in a new place, move it to 
a clear area in the 
LisaProject Examples 
folder, as shown. (Press 
with the pointer on the 
icon, move it, and release 
when the icon is where 
you want it.) 

3 If you want to throwaway 
the Special Project 
document, move it to the 
Wastebasket icon. When 
the document icon is on 
the Wastebasket and the 
Wastebasket icon 
highlights, release the 
mouse button and wait 
for the document to be 
deposited. 

Note: You can a/ways get back 
the last thing you've thrown 
away by opening the 
Wastebasket icon and moving 
the deposited document back 
out. 
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Do This 

4 Now set aside both the 
LisaProject Examples 
folder and ProFile by 
choosing Set Aside 
Everything from the 
File/Print menu. 

Notice that both the Folder and 
ProFile icons are now set aside 
on the desktop. 

5 You can put away the 
LisaProject Examples 
folder back in its filing 
home in the ProFile even 
when the ProFile window 
is closed. To do so, select 
the LisaProject Examples 
folder and choose Save & 
Put Away "LisaProject 
Examples" from the 
File/Print menu. 

Note: If you want to deselect a 
selected icon, click once when 
the pointer is not over the icon. 
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Do This 

6 When you are ready to 
work on something else, 
just open the ProFile 
again. When you want to 
turn off Lisa's power -
for example, over the 
weekend - press the lit 
on-off button, as shown. 
When you turn on the Lisa 
again, everything will 
reappear as you left it 
when you turned the Lisa 
off, including documents 
you may have left open on 
the desktop. Normally, 
you should leave the 
ProFile turned on. 
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A44 ::: Section A 

Using LisaProject 

You now have the basic skills necessary for using 
LisaProject to produce your own LisaProject documents. 
Because the concepts for using each Lisa tool are the 
same, you also have some of the basic skills for using 
other Lisa tools: LisaDraw, LisaGraph, LisaList, LisaCalc, 
and LisaWrite. 

There is much more you can do with LisaProject. You can 
learn about other LisaProject features by: 

• Going through other exercises in the LisaProject 
Tutorial, Section B. 

• Using the LisaProject Reference Guide, Section C, as 
you do your work. 

• Just experimenting as you use LisaProject. Remember 
- when experimenting, you usually have to select 
something before taking action with it. It's safe to 
experiment because most of the things you do can be 
undone by choosing Undo Last Change from the Edit 
menu. And if you're experimenting with a document 
you've torn off of a stationery pad, you can try almost 
anything and always start fresh by either choosing 
Revert to Previous Version from the File/Print menu, or 
by throwing the document away into the Wastebasket, 
and tearing off a fresh copy from the same stationery 
pad. 



Other LisaProject Features 

• Assigning several resources to the same tasks. 

• A "reduced to fit" view, allowing large schedule charts 
to be viewed on the screen all at once. 

• Special project tracking using the Resource chart to 
indicate the days remaining to complete specific tasks. 

• Being able to specify holidays, and one to seven day 
work weeks. 

• Choosing from a variety of typestyles for chart titles. 

• Cutting and pasting from LisaProject to LisaDraw. 
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Guide to Lisa Manuals 

Set up your Lisa following the setup procedures in the 
Lisa accessories box or in Appendix 1, Setup 
Procedures, in the Lisa Owner's Guide. 

Go through Section A, LisaGuide, in the Lisa Owner's 
Guide, for an introduction to the Lisa. 

If your dealer or service representative did not set your 
system Preferences so that the Lisa knows what external 
devices are attached, follow the instructions in Section 
D, Desktop Manager Reference Guide, under Set, in the 
Lisa Owner's Guide. 

Go to Section A, Getting Started, in the manual for each 
office tool that you want to learn, for the essentials of 
using that tool. 

~ Go to Section B, Lisa Fundamentals, in the Lisa Owner's 
Guide, for the background information you need before 
beginning long-term work on the Lisa. 

You are now ready to start dOing your own work on the 
Lisa: 
• If you want self-paced instructions for using a tool, go 

to Section B, Tutorial, in that tool manual. 
• If you want instructions for performing specific tasks 

with a tool, go to Section C, Reference Guide, in that 
tool manual. 

For specific instructions on filing and desktop 
management, go to Section 0, Desktop Manager 
Reference Guide, in the Lisa Owner's Guide. 

For more information on the Lisa hardware, tips on 
caring for the Lisa, and suggestions for troubleshooting 
when the system isn't working properly, go to the other 
sections of the Lisa Owner's Guide. 
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What's in the 
LisaProject Tutorial? 

This tutorial teaches you about LisaProject as it guides 
you step by step through several real-life examples. To 
get the maximum value from this tutorial, you should try 
out the examples on your Lisa as you go through it. 

All major LisaProject features are covered in the tutorial, 
but not always in fine detail. A complete description of 
each LisaProject feature can be found in Chapter 2 of 
Section C, the LisaProject Reference Guide, in this 
manual. 

Before you start this tutorial, be sure you have completed 
LisaGuide, in which Lisa introduces Lisa; you can find the 
LisaGuide diskette in the front pocket of the Lisa 
Owner's Guide. Also, you should have completed Section 
A, Getting Started with LisaProject, in this manual. If you 
haven't completed one or both already, now is a good 
time to do so. 

To complete the activities in this tutorial, you need 

• The blank LisaProject stationery pad that is on your 
Profile . 

• The sample documents for this tutorial, that are in the 
LisaProject Examples folder on your Profile. 

The arrow symbol (~) appears before each activity in the 
tutorial, and it means "Do something." For example, 

~ Turn the page to begin the tutorial. 

Bvii 
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Creating a Chart 

This chapter leads you step by step through the creation 
of a Schedule chart and its resulting Resource and Task 
charts. 

By following the activities in Chapter 1, you learn most of 
the standard procedures of resource management. In 
this chapter you learn how to 

• Get a blank Schedule chart. 
• Expand the drawing space. 
• Move milestone circles. 
• Draw task boxes. 
• Enter text into boxes and circles. 
• Draw arrows. 
• Get the resulting Resource and Task charts. 
• Print the charts. 
• Put the charts away. 

Throughout this chapter you assume the role of a 
corporate Director of Research and Development, 
keeping track of new product development. 
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LisaProject helps you plan and monitor projects. Based 
on information that you provide, LisaProject shows you 
the earliest and latest dates each task in your project can 
be started and finished. LisaProject also produces a 
Resource chart showing the order in which "resources" 
(people or equipment) are scheduled, and a Task chart 
showing the order in which tasks are scheduled. 

To create a Schedule chart, you first draw boxes or 
circles to represent, respectively, the "tasks" and 
"milestones" in your project; tasks have associated 
resources and time durations, milestones are events with 
no associated resources and no time duration. Then, you 
tell LisaProject the interdependence between the tasks 
and milestones. That is, you specify which ones come 
before others by drawing connecting lines that are called 
"arrows. " 

Once you create a Schedule chart, the resulting 
Resource and Task charts are generated automatically. 
All three charts together are called a "LisaProject 
document." 

Figure 1 illustrates a Schedule chart, with its various 
components identified. These components will be 
described in more detail later, as you learn how to create 
them. The Resource and Task charts are illustrated and 
described later in Figures 19 and 22. 



~----------""---------lisaProject orial 
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Arrow 

Milestone circle 

Figure 1. A Schedule Chart for Example 1 

Getting a Blank Schedule Chart 

To create a new LisaProject Schedule chart, 

~ Open the ProFile 
window by clicking twice 
on the ProFile icon. 

~ Tear off a sheet of paper 
for the new document by 
clicking twice on the 
LisaProject stationery 
pad icon. 

~ Name the new document 
by typing your initials 
followed by Ch 1. This 
allows other people to 
use the same ProFile 
and not get their 
documents confused. 

~ 
LlSaPrOJect Paper 
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~ Open the new 
document's window by 
clicking twice on the 
d ocu ment icon. 

Your screen should then look like Figure 2. The 
document name you have just entered is at the top, in the 
black band beneath the menu bar. Within the drawing 
area of the chart, there are reserved spaces for a title 
and subtitle, and there are milestone circles labeled 
"start" and "end." 

Title 

SubTi tle 

(0 

Figure 2. A Blank Schedule Chart 

Enlarging the Drawing Space 

When the blank Schedule chart appears on your screen, 
the drawing area allocated to it may not be enough to 
suit your needs. You may want to enlarge it. 

To do this, 

~ Move the pOinter to the 
size control box. 

~ Press and hold the mouse button as you pull the 
pointer down toward the bottom of the screen. 

~ Release the mouse button when your chart looks like 
Figure 3. 



D 

oltJl 

(~'l o 

Title 

SubTitle 

Figure 3. Enlarged Drawing Space 

Moving Milestone Circles 

8 

When the blank Schedule chart appears on your screen, 
the "start" and "end" milestones are located near the 
bottom of the screen, relatively close together. You may 
need to spread them out to provide more room for task 
boxes. 

Milestone circles are selected and moved by using the 
mouse to position the pointer. To do this, 

~ Position the pointer on 
any part of the "start" 
circle's outline and click 
once. The circle's outline 
appears shaded with 
eight dark handles 
around it. This indicates 
that the circle is 
selected. 

~ Press the mouse button 
and hold it down as you 
move the pointer to the 
left. A ghost of the 
milestone circle follows 
the pointer. Move it to 
the position shown in 
Figure 4. 
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~ Release the mouse 
button. The circle will 
remain selected. 

~ Move the "end" circle in the same manner to the 
position shown in Figure 4. 

Pointer 

El 

Title 

SubTi tle 

G 
Figure 4. Repositioned Milestone Circles 

Notice that the selected circle remains selected after you 
release the mouse button. It becomes unselected when 
you select another object, or click in an empty area of the 
drawing space. 

Drawing Task Boxes 

Task boxes are drawn with the mouse, which is also used 
to select, move, stretch, and shrink existing boxes. 

Follow each step below to draw the task boxes shown in 
Figure 1. 



Draw 

To draw a box, 

~ Move the pointer to the approximate position 
indicated for the pointer in Figure 4, then press and 
hold the mouse button down. 

~ While holding the mouse 
button down, move the 
pointer diagonally. The 
box grows as you move 
the pointer. 

~ Release the mouse 
button. Your box should 
look like the one in 
Figure 5. When you 
release the mouse 
button, a horizontal line 
and a blinking vertical 
insertion point will 
appear in the box you 
just drew. 

The horizonial line UWOUg:1 the midd:e of the box divides 
the box into separate areas for different kinds of text, as 
explained later. The blinking insertion pOint shows where 
text would be inserted if you were to type on the 
keyboard. 
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Ti tle 

SubTi tl e 

G 

Figure 5. Drawing the First Task Box 

Now, draw a second box a little smaller than the first box, 

~ Draw the second box using the same steps given 
above, but make it smaller and position it as shown in 
Figure 6. 

Figure 6. Drawing a Smaller Task Box 



Move 

As with milestone circles, the shaded outline of a 
selected box is used to move the box. To move the small 
box you just drew, 

~ Select it by clicking once on it. 

~ Position the pointer on 
any side of the object. 
Avoid touching any of 
the eight dark handles. 

~ While pressing and 
holding the mouse 
button down, move the 
pointer. A ghost of the 
box follows the pointer. 
Move the box to the • __ ~iIr",NMWNNMYlUN. 
position shown in Figure 
7, then release the 
mouse button. 

El 

Ti tle 

SubTitle 

G 

Figure 7. Moving a Task Box 
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Copy and Paste 

A box can be duplicated by selecting the box, copying it 
to the Clipboard, indicating the position it is to be copied 
to, and pasting it from the Clipboard to the new position. 

When a box is copied, the original version still remains 
where it was. 

To copy the first box to another position, 

~ Select the first (upper
left) task box by clicking 
once on it. 

~ Choose Copy from the 
Edit menu. This copies 
the selected box to the 
Clipboard. 

Select All of Document etA 

~ Move the pOinter to the center of where the copied 
box is to be pasted, as shown in Figure 8, and click 
the mouse button once. 



Ti tle 

SubTitle 

G 
I 8 

QI tJl 

Paste position I 

Figure 8. Indicating the Paste Position 

~ Choose Paste from the Edit menu. The box will then 
be copied, as shown in Figure 9. 

Ti tle 

SubTitle 

B 
011 
V t==j 

Figure 9. Pasting a Copied Task Box 
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To complete the drawing of task boxes for this example, 
repeat the copy operation to get the fourth box, 
assuming the third box is still on the Clipboard, 

~ Move the pointer to the position where the center of 
the next box is to be pasted and click the mouse 
button once. 

~ Choose Paste from the Edit menu. Your chart will now 
look like Figure 10. 

Title 

SubTitle 

Figure 10. Pasting the Fourth Task Box 

Stretch and Shrink 

The eight dark handles on the outline of a selected box 
are used to stretch or shrink the box. Stretching and 
shrinking is done by first selecting the box, then pulling 
or pushing on one of the eight dark handles with the 
pOinter until the box is the right size. 

To stretch the smallest task box in Figure 10, 

~ Select the box by 
clicking once on its 
edge. 



~ Move the pointer onto 
the bottom-right corner 
handle, then press and 
hold the mouse button 
down. 

~ While holding the mouse 
button down, move the 
pointer. A ghost of the 
box will stretch. When 
the box is the desired 
size, release the mouse 
button. Try to make it 
look like the one in 
Figure 11. 

~111.ItIiIIUIIIIIIII'III"' .. n'IIf'llIttlllllllfilllC-----' 

1--------------------------1 
~ 

1.\W ... W.WI.·.WNN~YMYNNN.WIN~ 

Boxes can be stretched in one dimension by pulling the 
middle handle on any side. They can be stretched in two 
dimensions by pulling on a corner handle. 

El 

Figure 11. Stretching a Task Box 
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Entering Text 

There are three areas where text can be entered on a 
Schedule chart: 

• Title and subtitle text, for which space is reserved at 
the top of the chart, as shown in Figure 1. 

• Task text, which consists of a label, resource name, 
and duration entered inside a task box, as shown in 
Figure 12. 

• Milestone text, which consists of a label entered inside 
a milestone circle, as shown in Figure 13. 

Label Label 

Tes lng 

~ JUdy ij 

l 

Resource Duration 

Figure 12. Task Text Figure 13. Milestone Text 

You begin text entry by moving the pointer to a text area 
and clicking the mouse button once, twice, or three 
times: 

• One click places an insertion pOint. 
II T'vvo clicks selects a wOid. 
• Three clicks selects an entire title, label, or resource 

line. 



You can tell where the text areas of the chart are located 
because the pointer changes shape when it is in them: 

When the pointer is in a 
drawing area, it looks like 
this: 

When the pOinter can be 
used to select something 
such as a task box or menu, 
it looks like this: 

When the pointer is in a text 
area, it looks like this: 

Title and Subtitle 

+ 

x 
The areas reserved for title and subtitle text are the two 
lines at the top of the chart labeled "Title" and 
"Su b Title." 

To replace the words "Title" and "SubTitle" with new 
text, 

~ Move the pointer to the 
word "Title" and click .... 
the mouse button twice 
to select it. SubTitle 

~ Type 

LisaProject Tutorial 

~ Press the (Tab) key to LisaProject Tutorial 
advance to the subtitle 
area. M_D 

~ Type 

Example 1 

If you make an error, use the (Backspace) key to erase the 
character and retype. 
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Milestone Labels 

The areas reserved for milestone text are inside the 
milestone circles. 

To replace the word "end" in the right-hand milestone, 

~ Select the word "end" by clicking twice on it. 

~ Type 

stop 8 
Task Labels, Resources, and Durations 

To enter a label into the upper-left task box of your 
example, 

~ Move the pointer to the 
upper portion of the task 
box and click the mouse 
button once. A blinking 
insertion point will 
appear. 

~ Type 

Product 

~ Press the (Return) key to create a second line for the 
title. Your task box will expand if more room is 
needed. 

~ Type 

Research 
Product 
Research 

To enter a resource name and duration into the task box, 

~ Press the (~) key after entering the task label, or 
place an insertion point in the lower-left side of the 
box. 



~ In the resource area, 
type 

Bob 

Prod'Jot 
Research .•......................... 
Bob 

~ Press the (T~~) key to advance to the duration area, 
which is the lower-right side of the box. 

~ In the duration area, 
type 

10 

Product 
Research 

Bob 10 

~ Press the (Return) key to open up a second line for a 
second resource and duration. Your task box may 
expand if more room is needed. 

~ In the resource area, 
type 

Robin 

Product 
Research 

Bob 10 
Rot'ln I 

~ Press the CTab) key to advance to the duration area, 
which is the lower-right side of the box. 

~ In the duration area, 
type 

7 

Produot 
Resesrch 

Bob 10 
RObln .~. 

In the steps above, it is not necessary to use the (Tab) key 
to advance to the duration area. As an alternative, you 
can place an insertion point in any text area, at any time, 
by moving the pOinter there and clicking the mouse 
button once, then you can enter the text. 

Whenever you need to enter multiple lines for labels or 
resources, use the (Return) key to create those lines. 

~ Enter all additional text shown in Figure 14 to 
complete the Example 1 chart. 
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LisaProject Tutorial 

Example 1 

8 
QIOI 

Produc~ 
Research 

BOO 10 
RoOln 7 

Figure 14. Text for Example 1 

Changing Type Style 

Type style, both font and pitch, may be changed for: 

• All text in all boxes and all circles. 
• The entire title or the entire subtitle. 
• Single characters in the title or subtitle. 

To change the style of all boxes and circles, 

~ Choose Select All of 
Document from the Edit 
menu. All task boxes 
and milestone circles 
appear dark when you 
do this as shown in 
Figure 15. 

Undo last Change 

Cut 
Copy 
Paste 

wx 
wc 
wV 

Select All of Oo(urnent [, .• A 
... " "" .. .... "" yl."" 

~ Choose a type style, 
such as Ital ic, from the 
Type Style menu. 

Plain Text 
Underline 

Bold 

WP 
wU 
W8 

~ Click once in the empty space of the chart to deselect 
the entire document. Your chart will now look like 
Figure 16. 



Li saProj eet Tut ori al 

Example 1 

Figure 15. Selecting All of the Document 

LisaProject Tutorial 

Example 1 

G 
I_ ...... -~~~~~ ....... _I 
I· ~., -I 

Figure 16. Type Style Change 

To change the type style of the title, 

G 

o 
[] 

~ Select the title by moving the pointer to it and clicking 
the mouse button three times. 

~ Choose Bold from the Type Style menu. 
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Drawing Arrows 

Arrows are actually lines, without arrow heads, that 
connect tasks and milestones. The arrows show the 
dependencies between tasks and milestones. By 
following the arrows from left to right, you can see which 
tasks and milestones must be completed before others 
can be started. 

Arrows can only be drawn from left to right, because this 
is the direction in which time moves in a Schedule chart. 
That is, the origin of the arrow must be a task box or 
milestone circle that is located to the left of the arrow's 
destination box or circle. 

To draw the first arrow in Example 1, 

~ Move the pointer inside 
the "start" milestone, 
then press and hold the 
mouse button down. 

~ Move the pointer to the 
first task box. 

~ Release the mouse button. 

Pl~Wt 
Res~"C17 

.. _----._--._--_._--.------_ .. 
500 .to 

~\ ~--.~--..I ( \ ...... --- _RoDin.";1 

( S~T) 
.~ 



Finish drawing all the arrows for Example 1, as shown in 
Figure 17: 

~ Draw an arrow from the "start" milestone to the 
second task box. 

~ ~~------~ ~------- -.. NS.l1(~t 
ReSes.J?J17 

~ Draw an arrow from the task box labeled "Product 
Research" to the task box labeled "Development." 

PJ"oauct 
ReSea.l"Cn 

:1.0 .., 
.' 

~ Draw an arrow from the task box labeled "Market 
Research" to the task box labeled "Development." 

l',W1(~t 
ReSes.J?J17 

------""--_ .. _-------_ .. --------
. ..71.1dy ." 

lJet~ 1 GplVdi7 t 
....... -----_ ....... _-------_ .. -

RoDIn ilJ 
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~ Draw an arrow from the task box labeled 
"Development" to the task box labeled "Testing." Be 
sure that the third task box is located to the left of the 
fourth box, otherwise an alert box will appear on your 
screen. 

r~stlnq 

............................... 
JI./J1y JJ 

oeWJ 1 GpIV8'1 t 
....... _-.-........... -----_ ... 

R>XJJn iJJ 

~ Draw an arrow from the task box labeled "Testing" to 
the "end" or "stop" milestone. 



Customize Chart 

LisaProject Tutorial 

Example 1 

Figure 17. Complete Example 1 Schedule Chart 

If you try to draw an arrow from right to left, the alert box 
shown in Figure 18 will appear. If this happens, position 
the pOinter over the word "Cancel" and click the mouse 
button to dismiss the alert box. Then move one or both 
of the boxes you are trying to connect so that the origin 
box is clearly to the left of the destination box. 

Cancel 

Draw arrows from left to right. 

Figure 18. Alert Box for Arrow Drawing 

If you draw an arrow in the wrong place, you can delete it 
by moving the pOinter to it and clicking once to select it, 
and then choosing Cut from the Edit menu. 
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Whenever you create a Schedule chart, a Resource and a 
Task chart are automatically generated as by-products. 

To get the Resource chart that has resulted from the 
example you have just created, 

~ Choose Resource from 
the Chart menu. "'/Schedule 

Task 

Your Resource chart should look like the one shown in 
Figure 19. Just as you did with the Schedule chart, 
replace the words "Title" and "SubTitle" with 
"LisaProject Tutorial" and "Example 1," respectively. 

El 
'\ 

1131113 1/101l13 11171113 1/Z~/83 ll311l13 
~ 

Zl71l13 Q 

Bob I Product ReseerCll 

I Product ReseerCll ' 

I Merket ReseerCll 

Figure 19. A Resource Chart 

i Title 

SubTi tIe 

I DevelOpMent 

Testlng= 

If your Resource chart doesn't look like Figure 19, get the 
example chart provided in the LisaProject Examples 
folder. To do this, 

~ Choose Set Aside from the File/Print menu so that 
you can see the ProFile window. 

~ Open the LisaProject Examples folder. 

~ Tear off a chart from the stationery pad called 
Chapter 1. 



~ To name the chart, type your initials, followed by 
Ch1. 

~ Open the chart by clicking twice on it. 

~ Choose Resource from the Chart menu. 

The Time Scale 

The Resource chart in Figure 19 has a time line at the 
top. The time starts with January 3, 1983, or the nearest 
working day to the first day of the year date, and 
continues at one-week, two-week, four-week, or eight
week intervals. 

You can change the Resource scale so that all bars 
become visible. To do this, 

~ Choose Time Scale on 
the Customize menu. A 
dialog box like Figure 20 
will appear. 

Calendar ... 
Set Scheduled Oates ... 
Remove Scheduled Oates 
f.Hspll.'lY Olltes \ \, 

r- Fi Ie/Print Edit Type Style Page Layout Customize Chart 

Scale: 

• 1 week D Z week D 4 week D 8 week 

Figure 20. Time Scale Dialog Box 

~ Check 2 Week. 

~ Click OK. 

( Cancel 

( OK ) 

Your Resource chart will look like Figure 21. 
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11.3/83 1117/83 11.31/83 

I I 
60b i Product Researcn i 

I Product Res~arcn ! 
, Iroev--:el-OPM-enC-t -'---1 

RobIn 

Judy 
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Slack time 

Figure 21. Rescaled Resource Chart 

Features of the Resource Chart 

Resource charts are used to schedule resources. The 
tasks, which are shown as horizontal bars, are organized 
by resources, which are shown along the left side of the 
chart. 

The length of a bar represents the duration of the task, 
and all tasks to be performed by a given resource are 
grouped together. 

The shaded area on the" Market Research" task bar 
indicates "slack time." Slack time is the additional time 
the task may last without affecting overall completion 
time for the entire project. Tasks that have slack time are 
not "critical tasks," and therefore are not highlighted 
with dark outlines on the Schedule chart. 

The title and subtitle of the Resource chart must be 
entered independently of the Schedule chart's title and 
subtitle. The steps for doing this are the same as those 
described in the Titles and SubTitles section earlier in 
this chapter. 



Getting the 
Task Chart 

There are occasions when resource scheduling does not 
reflect the optimal allocation of resources, since 
LisaProject does not use the time-consuming linear 
programming approach that classical scheduling 
programs use. 

Nonoptimal scheduling may occur when a single 
resource is needed by two or more separate tasks. If this 
occurs, it can be adjusted by using Scheduled Dates, as 
described in Chapter 2 of this tutorial. 

Whenever you create a Schedule chart, a Resource and a 
Task chart are automatically generated as by-products. 

To get the Task chart that has resulted from the example 
you have just created, 

~ Choose Task from the Chart menu. 

Your Task chart should look like the one shown in 
Figure 22. 

Time line 

~~ ______________ ~ __________________ o 
~ ~ ~ ~ ~ ~~ 

tf 1. 1 
~-------------I---++---"""';-_LisaProject Tutorial 
Title : I : 
~~-----------If----I--!------+---~xample 1 ; 
SubTitle 

Slack time 

Resource 

Market 
ResearCh 

-------------!OevelopMent 
Task label 

Testing 

!:-R06_1In __ -.,--:,l- _ 
~--r_,!--"llrJu(lTI 

Task duration Task 

Figure 22. A Task Chart 

Current date 
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If your Task chart doesn't look like Figure 22, get the 
example chart provided in the LisaProject Examples 
folder. To do this, 

~ Choose Set Aside from the File/Print menu so that 
you can see the ProFile window. 

~ Open the LisaProject Examples folder, if it's not open. 

~ Tear off a chart from the stationery pad called 
Chapter 1. 

~ To name the chart, type your initials, followed by 
Ch1. 

~ Open the chart. 

~ Choose Task from the Chart menu. 

Task charts are very similar to Resource charts, but the 
resources and tasks are organized differently. 

In the Resource chart shown in Figure 19, tasks are 
grouped according to the resource which performs them; 
within this group, they are sorted by early start time. 

In the Task chart shown in Figure 22, tasks are sorted by 
early start time and resources appear as labels in the 
horizontal bars. These charts are used to schedule tasks. 

To print your document, you naturally have to have a 
printer connected to your Lisa. If you don't have a printer, 
or it is not set up, you may skip this section for now, and 
proceed to Filing the LisaProject Document, later in this 
chapter. 

To find out how to set up your printer and hook it up to 
your Lisa, refer to the manual that came with your printer. 

You may also need to set up Preferences correctly for 
your printer. If you have not already done this, do it now. 
To set up Preferences for your printer, refer to Section D, 
Desktop Manager Reference Guide, in the Lisa Owner's 
Guide, under Set Printer Configuration. 

Once the printer and Preferences have been set up, 
printing your first document is very easy. 

~ Just choose Print from the File/Print menu. 

A Print dialog box appears on your screen, like Figure 23. 



Filing the 
LisaProject 
Document 

Print... • Finished Quality 0 Quick Draft (Text Only) ( (once I 
o One Copy While You Wait • While You Work 

• All Pages DOnly pages: i.:.·.::·.·.:::.~:::::~.:::::~:~:::·.:::·.:::.·.J Through: C::.·.:::::::·.~.:::::·.:·.::::::~.·.:.·.::·.·.::·.·.::.l 
Number of Copies: .mG][][I]w0IIJITJ§J (r--O-K-" 

Figure 23. Print Dialog Box 

All printer settings are as you need them right now. You 
learn to use the different settings available in the Print 
dialog box and the Format for Printer dialog box in 
Section C, LisaProject Reference Guide, Chapter 2, 
under Print. 

~ Click OK in the dialog box. 

Your Lisa then displays a message saying that it is 
preparing to print your document and allow you to 
continue working, since the Print dialog box specified 
that you wanted to print your document while you work. 
After that message, the Lisa displays an alert box asking 
you if you want to cancel the printing or proceed with it. 
To respond to the message, 

~ Click Proceed to continue working while your 
document is being printed. 

If your Lisa cannot print the document while you work, it 
will display a message to let you know that, and you will 
have to wait until the document is finished printing and 
the message disappears. 

To save the charts that you just created, 

~ Choose Save & Put 
Away from the File/Print 
menu. 

Revert to Previous Version 

The document window closes automatically, and its 
document icon goes back beside the stationery pad in 
the disk window. 
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Now you can move the document icon to an empty place 
in the disk window. 

~ Move the pointer into the LisaProject document icon. 
Press and hold the mouse button while moving the 
icon to an empty place in the disk window. 

~ Release the mouse button. 

This completes Chapter 1. Go on to the next chapter, if 
you like, or come back to it at a later time. 



Chapter 
Summary 

Get a new chart 

Expand the drawing area 

Move an object 

Draw a task box 

Copy and paste 

• Open the ProFile window. 

• Tear off a chart from the 
LisaProject stationery 
pad. 

• Name the chart. 

• Open the new chart. 

• Press and hold the 
mouse button on the size 
control box. 

• Move the pOinter. 

• Release the mouse 
button. 

• Select the object and 
hold the mouse button 
down. 

• Move the pointer. 

• Release the mouse 
button. 

• Press and hold the 
mouse button. 

• Move the pointer 
diagonally. 

• Release the mouse 
button. 

• Select the object. 

• Choose Copy from the 
Edit menu. 

• Click once at the center 
of where you want to 
copy to. 

• Choose Paste from the 
Edit menu. 
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Stretch and shrink 

Enter title and subtitle 

Enter milestone label 

Enter task label 

Enter task resource 
and duration 

Change type style 

• Select the object. 

• Move the pointer onto a 
handle. 

• Press and hold the 
mouse button. 

• Move the pointer. 

• Release the mouse 
button. 

• Select the' 'Title" area. 

• Enter the title. 

• Press the CTab) key. 

• Enter the subtitle. 

• Position the pOinter in the 
circle and click the 
mouse button once. 

• Enter the label. 

• Position the pOinter in the 
label area of the box and 
click the mouse button 
once. 

• Enter the label. 

• Position the pOinter in the 
resource area of the box 
and click the mouse 
button once. 

• Enter the resource name. 

• Press the C~) key. 

• Enter the duration. 

• Select the text to be 
changed. 

• Choose the style from the 
Type Style menu. 



Draw an arrow 

Get Resource chart 

Change Resource 
time scale 

Get Task chart 

Put the charts away 

Discard the charts 

• Position the pointer in the 
left-hand circle or box 
and hold the mouse 
button down. 

• Move the pointer to the 
right-hand circle or box 
and release the mouse 
button. 

• Choose Resource from 
the Chart menu. 

• Choose Resource on the 
Chart menu. 

• Choose Time Scale on 
the Customize menu. 

• Check time period for 
scale. 

• Click OK. 

Ii! Choose Task from the 
Chart menu. 

• Choose Save & Put Away 
from the File/Print menu. 

• Choose Set Aside from 
the File/Print menu. 

• Move the icon for the 
chart to the Wastebasket 
icon. 
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• If you haven't set up your 
printer yet, see the 
manual that came with 
your printer. 

• If you haven't set printer 
Preferences yet, see 
Section D, Desktop 
Manager Reference 
Guide, in the Lisa 
Owner's Guide, under 
Set Printer 
Configuration. 

• If you need to change any 
of the options in the 
Format for Printer dialog 
box for your document, 
choose Format for 
Printer from the File/ 
Print menu and change 
the options. 

• Choose Print from the 
File/Print menu. 

• Respond to any dialog 
boxes that may appear. 

• Click OK. 
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Entering Dates 

This chapter leads you step by step through the methods 
of entering and updating dates for a Schedule chart and 
Resource chart. By following the activities in Chapter 2, 
you learn how to, 

• Create the calendar. 
• Display dates. 
• Enter scheduled start and finish dates. 
• Enter work days remaining for a task. 
• Perform "what if" analysis. 

This chapter uses the same example that was used in 
Chapter 1. Again, you assume the role of a corporate 
Director of Research and Development, keeping track of 
new product development. 
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To retrieve your filed chart, 

~ Open the ProFile window. 

~ Open the chart that you 
created in Chapter 1. 

If you didn't complete Chapter 1, or if your chart doesn't 
look like Figure 17, 

~ Open the LisaProject 
Examples folder. 

~ Tear off a sheet of paper 
from the stationery pad 
named Chapter 1. 

~ Name the chart. 

~ Open the chart. 

CJ 
LlsaPro Ject Examples 

Ch~ter 1 

Creating the calendar consists of specifying the years 
during which the project will occur, the number of 
working days in a week, and the dates of nonworking 
holidays. 

To create the calendar, first look at the calendar dialog 
box, 

~ Choose Calendar from 
the Customize menu. A 
dialog box like the one in 
Figure 24 appears. 

Several entries in the calendar appear as "mm/dd/yy." 
These entries stand for month, day, and year, with two 
digits for each. 



Calendar-Year 
Range 

Calendar: from January 1 19 .. 
to December H 19 83 

Working Days per Week: 

Current day of praject: 

Holidays: 
mm/dd/'yy 
mm/ddlyy 
mm/dd/yy 
mm/ddlyy 

mm/ddlyy 
mmlddlyy 
mmlddlyy 
mm/ddlyy 

mm/dd/yy 

mmlddlyy 
mmlddlyy 
mm/ddlyy 
mm/ddlyy 

Figure 24. Calendar Dialog Box 

mmldd/yy 
mmldd/yy 
mrn/dd/yy 
mmlddlyy 

mm/ddlyy 
mm/ddlyy 
mrn/ddlyy 
mm/ddlyy 

( Cancel 

OK 

LisaProject assumes that projects start on January 1 of a 
year, or the nearest working day to that date. This date 
can be changed. 

At this point, you will only change the years in which the 
project starts and ends. In a later section, Entering 
Scheduled Dates, you will change the month and day that 
the project starts and ends. 

To change the starting and ending year to 1984, 

~ Move the pointer to the two-digit start year and click 
the mouse button twice to select it, if it is not already 
selected. 

~ Type 

84 

~ Press the (Tab) key to select the next field, which is the 
two-digit end year. 

~ Type 

84 

Days Per Week 

Days Per Week defines the number of working days in a 
week. The usual number is 5. If you enter 6, then 
Saturday is a working day. If you enter 7, then every day 
including Sunday is a working day. 

LisaProject assumes that resources are available 5 days 
per week. You can enter a different number of days per 
week, by selecting the days per week field and entering 
another number between 1 and 7. 
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Part-time resources are to be treated the same as full
time resources. Since LisaProject is a calendar-oriented 
scheduling system, it only tracks elapsed time on a 
project. Therefore, no distinction is made between full
and part-time workers or equipment usage. 

Current Date 

The current date is the date on which you are viewing the 
charts. Typically, it is changed each day that you display 
the charts. 

To enter this date, assuming the calendar dialog box as 
shown in Figure 24 is displayed, 

~ Move the pOinter to the current date and click the 
mouse button three times to select the date. 
Alternatively, press the (~) key until this date 
becomes selected. 

~ Type 

1/27/84 

The current date will appear as a dark vertical bar in the 
Resource and Task charts. This date will not affect any 
scheduling; it is only a reminder of the current date. 

Holidays 

Holidays are nonworking days. LisaProject will not 
schedule any work on days which you specify as holidays. 

If you are using 5 or fewer days per week for working 
days as explained in the Days Per Week Section, then 
you don't need to enter holiday dates that fall on 
weekends; LisaProject will recognize these weekend 
days as nonworking days, whether or not they are 
specified as holidays. 

To enter holidays, assuming the calendar dialog box is 
still displayed, 

~ Select the first "mm/dd/yy" entry reserved for 
holidays by pressing the (!a~~) key or by clicking on it 
three times. 

~ Type 

1/1/84 

~ Press the (Tab) key to select the next holiday. 



Displaying Dates 

~ Type 

2/14/84 

Saving the Calendar 

When you are finished entering or changing dates in the 
calendar dialog box, you can save them and cause 
recalculation of any displayed dates by clicking the OK 
box: 

~ Click OK. 

If you click Cancel instead of OK, the changes you have 
made to the calendar will be ignored. 

Now that the calendar is set up, you can display the task 
and milestone dates LisaProject has calculated for you. 

Before you begin, make sure that the Schedule chart is 
displayed on your screen. If it is not, 

~ Choose Schedule from the Chart menu. 

To display the dates, 

~ Choose Display Dates 
from the Customize 
menu. A dialog box like 
Figure 25 appears. 

[alendar ... 
Set Scheduled Dates ... 
Remove Schedu I ed Dates 
Display Dates... r,~ 

nm~~ Sfnl~.~ '" 
D(JUs rlemnininf:l '" 

Change Task to Mi lestone 

( [ancel 

Early Start 0 On • Off Early Finish 0 On • Off 

late Start 0 On • Off Late Finish 0 On • Off 

Figure 25. Dates Dialog Box 

~ Check all of the On boxes by moving the pointer to 
each box and clicking once. 

~ Click OK. 
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The dates for tasks and milestones will be displayed in 
the positions shown in Figure 26. 

Early start I 
J.,,'2/~' 

e 
l./Z/~' 

Late finish 

Milestone 

Early start I 
1/Z/8JI 

1." '2" '8iJ 

Late startl 

Figure 26. Display Format for Dates 

I Early finish 

1/1.5.,/~%' 

IOrlw~wt 
Rese.·~.rcl? 

10 .. 
I' 

1/16/81.J' ........ 

I Late finish 

Task 

Each milestone has two dates: early start on top, late 
finish on the bottom. Each task has four dates: early start 
and early finish on top, late start and late finish on the 
bottom. 

Early Start: The date a task or milestone will start, given 
the early finish dates of preceding tasks or milestones. 

Early Finish: The date a task will finish, given the early 
finish dates of preceding tasks or milestones. Since 
milestones have no duration, their early start and early 
finish dates are the same. 

Late Start: The date a task will start, given the late finish 
dates of following tasks or milestones. 

Late Finish: The date a task or milestone will finish, 
given the late finish dates of following tasks or 
milestones. Since milestones have no duration, their late 
start and late finish dates are the same. 



Entering 
Scheduled Dates 

LisaProject Tutorial 

Example 1 

Figure 27. Schedule Chart with Dates 

Scheduled dates are dates that you enter. They override 
dates that LisaProject has calculated based on the 
calendar, the task durations, and the eligibility of 
resources. You can override any date that is displayed, 
as long as the date you enter is possible to achieve, given 
the other constraints of scheduling. For more 
information on scheduled dates, see Appendix 5, 
LisaProject Scheduling, in this manual. 

Scheduled dates are typically entered to reflect real-life 
dates or to control the allocation of scarce resources. 

The scheduled dates you enter appear underlined in the 
Schedule chart. They replace the dates that were in those 
positions before; all subsequent dates will be 
recalculated. 

To enter a scheduled date for the project start, 

~ Select the "start" 
milestone. 

I 
I 
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~ Choose Set Scheduled 
Dates from the 
Customize menu. The 
dialog box shown in 
Figure 28 appears. Remove Scheduled Dates 

Display Dates ... 

Start task no earl ier than: .... 
Finish task no later than: mm/dd/yy 

Figure 28. Scheduled Dates Dialog Box 

~ To replace the early start date, type 

1117/84 

~ Click OK. 

To enter a scheduled date for the project finish, 

~ Select the "stop" milestone. 

( (ancel 

OK 

~ Choose Set Schedule Dates from the Customize 
menu. 

~ Select the Late Finish .* entry, which currently 
has an "ASAP" value. 

~ Type 

2/27/84 

~ Click OK. 

For a project finish date of "ASAP," which means as 
soon as possible, LisaProject will calculate the earliest 
finish date possible, based on the project start date and 
the task durations you have entered. The project finish 
date is associated both with the end milestone and with 
the finish of the last task in the project. 

Display the Schedule chart now, if you are not already 
doing so, to see the change that scheduled dates 
produce. Your Schedule chart should look like 
Figure 29. 



LisaProject Tutorial 

Example 1 

Figure 29. Schedule Chart with Rescheduled Dates 

Now switch to the Resource chart: 

~ Choose Resource from the Chart menu. Your chart 
should look like Figure 30. 

11l7/6ij l!31/6ij 2llij/6ij 21Z8/6ij 31l3/6ij 

BOb Product Research 

Robin 
IPrOduct Rest

h 
t-loev-elo-pMen-t-..l....--'1 

JUdy 

Figure 30. Resource Chart with Rescheduled Dates 

'21 
[J 

H""I",i",i"i I 
~jmm: 

I 
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The current date, as it was entered on the calendar, is 
represented by the dark vertical line. 

If you enter a later than ASAP project finish date, the 
horizontal bars of the Resource chart will extend to 
include more stack time. In this case, none of the tasks 
is highlighted with a dark edge in the Schedule chart. 

As tasks are started, you can update the the Resource 
chart by specifying the number of days remaining in the 
task. 

To update work days remaining for the second task in 
Example 1, 

~ Choose Resource on the Chart menu. 

~ Select the bar labeled "Market Research" by moving 
the pointer to it and clicking the mouse button once. 
The bar will appear dark. 

~ Choose Days Remaining from the Customize menu. A 
dialog box like that in Figure 31 will appear . 

Days remaining in task: • 
Figure 31. Work Remaining Dialog Box 

~ Type 

2 

~ Click OK. 

~ Deselect the task bar by clicking in an empty area of 
the Resource chart 

The Resource chart will look like Figure 32. The heavy 
shading on the left side of the bar shows the completed 
portion of the task if you assume the duration as 
originaiiy entered. The white area in the middle of the bar 
represents work remaining. The light shading on the right 
side still represents slack time. 



l/17/8U 1/31/8U 2128/8U 
.¥ 

3127/8U ~ 

Bob 

Robin 

JUdy 

lisBPTojer.t Tutori:il 

:x: 

Product Research 

I Product Res~Jch 
i I i':-_Dev-:--"eloPMen-:---t-'-------,j 

II 
111I11111 

I 
G 
Q 

~IO~ 

Figure 32. Resource Chart with Updated Task 

"What If" Analysis At the beginning of a project, you may want to determine 
the effects of longer or shorter task durations. For 
example, if certain tasks take fifty percent longer than 
their expected durations, what 'N!!! be the effect on tots! 
project completion time? 

You can also test the effect of different scheduled dates. 
For example, if the project finish date is to be earlier, 
what wi" be the impact on task slack time? 

This type of "what if" analysis can be done by simply 
creating two sets of charts, each with different task 
durations or scheduled dates, and comparing the 
results. 

By selecting optimistic or minimum task durations for 
one set of charts, and pessimistic or maximum durations 
for the other set of charts, you can arrive at a range of 
project completion times. You may also wish to create a 
third set of charts showing expected task durations. 

To create a "what if" example using Example 1, 

~ Close the Ch 1 document you are currently working 
with by choosing Save and Put Away from the File/ 
Print Menu. 
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~ Choose Duplicate from the File/Print menu. 

~ Move the flashing 

I~I duplicate Ch 1 icon to a -
new location. A message 11 may appear saying that sJmCh1 

the document is being Ilrlll 
duplicated. 

~ Name the duplicate with 

~ your initials, followed by 

~ Ch1A sJmCh1 
synChlA 

~ Open the chart. 

~ Move the pOinter to the duration for the "Market 
Research" task and click the mouse button twice to 
select it. 

~ Type 

15 

~ Choose Resource from the Chart menu. 

Your Resource chart will now look like Figure 33. 
Compare this with Figure 32. 

111718ij 1!3118ij 211ij18ij 21Z8/8ij 311318ij ¥ 
31Z718ij ~ 

1 1 

LisaPr~ject Tutori~l 

~xample 1 

Bob Product Research 

1'",PrOduct ReS~Ilar'Ch I"~, ~ 
ID~velop~ent 

RObin 

JUdy Mar~et ResearCh I 

Figure 33. Resource Chart with Revised Task Duration 



Filing the 
LisaProject 
Document 

Now file the document that you have just worked with. To 
do this, 

~ Choose Save & Put Away from the File/Print menu. 

You can leave the document where it is in the disk 
window, or you can create a folder to contain all the 
related documents. 

~ Move the pointer into 
the empty folder pad 
icon and click the mouse 
button twice. 

~ Type 

Tutorial-

followed by your initials. 

To file the document in your new folder, 

~ Move the pointer into 
the document icon. 
Press and hold the 
mouse button while 
moving the document 
icon over the folder icon. 

~ Release the mouse 
button when the folder 
icon flashes. 

~ Move the folder icon to 
an empty place in the 
disk window. 

~ Move the document that 
you worked with in 
Chapter 1 into your new 
folder to keep all your 
examples together. 

L:J 
Empty Folders 

• '.-1 
This completes Chapter 2. Go on to the next chapter, if 
you I ike, or come back to it later. 
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Create the calendar 

Display dates 

Enter scheduled dates 

Enter work days 
remaining 

Analyze "what if" 

• Choose Calendar from 
the Customize menu. 

• Select the date field. 

• Type the new date. 

• Click OK. 

• Choose Display Dates 
from the Customize 
menu. 

• Check the dates you want 
to see. 

• Click OK. 

• Select the task or 
milestone. 

• Choose Scheduled Dates 
from the Customize 
menu. 

• Select the date to be 
scheduled. 

• Enter the scheduled date. 

• Click OK. 

• Choose Resource on the 
Chart menu. 

• Select the task bar. 

• Enter the work days 
remaining. 

• Ciick OK. 

• Duplicate your chart. 

• Change task durations or 
scheduled dates. 

• Compare the two 
versions. 
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Creating Large Charts 

This chapter leads you step by step through the methods 
of expanding a small chart into a large, more detailed 
chart. By following the activities in Chapter 3, you learn 
the details of large-scale resource management. In this 
chapter you learn how to, 

• Enlarge the Schedule drawing space. 
• Scroll and zoom. 
• Rearrange charts. 
• Break tasks into subtasks. 
• Add milestones. 
• Copy charts to LisaDraw. 
!!!!! Enlarge paper size for printing. 
• Reduce chart size by reducing type size. 

This chapter begins with the same example that was 
used in Chapters 1 and 2, but expands it into a larger 
example. Again, you assume the role of a corporate 
Director of Research and Development, keeping track of 
new product development. 
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To get the example chart used in Chapter 1, get it from 
the LisaProject Examples folder. To do this, 

~ Open the ProFile window. 

~ Open the LisaProject Examples folder. 

~ Tear off a chart from the Chapter 1 stationery pad. 

~ To name the chart, type your initials, followed by Ch3. 

~ Open the chart. 

For the expansion of Example 1 into a larger chart, you 
need a drawing space larger than one page. The drawing 
space can be expanded to any size you wish. This is done 
by adding pages to the right or bottom of the first, 
original, page as shown in Figure 34. 

First 
Add 

Page 
Right 
Page 

Add 
Bottom 
Page This page is automatically 

added if both a right page 
and a bottom page are added. 

Figure 34. Adding Pages 

After adding pages, you can choose to have the page 
edges either displayed, called "previewed," or hidden. 
Displaying the page edges lets you see where you are in 
the available drawing space. Hiding the display of page 
edges is useful when you want to draw without being 
distracted by edge lines. 

During printing, each page of a multi-page chart is 
printed separately. You can then tape them all together 
or pin them to a wall. 

If you add pages but leave them blank, the blank pages 
will be removed when the chart is saved. 



To enlarge the drawing space for your chart and to 
display the page edges, 

~ Choose Add Page on 
Right from the Page 
Layout menu. 

~ Choose Preview Pages from the Page Layout menu. 

Scrolling and Zooming 

The page edges that you made visible in the last step, 
above, can be viewed by scrolling the drawing space with 
the view buttons, which look like pages with folded 
edges. 

To scroll to the right and back again, 

~ Move the pointer to the 
view button in the lower
right corner of the 
screen and click the 
mouse button once. The 
vertical page break 
between the left and 
right pages will appear 
when you do this. 

~ Click on the same view button again. The edge of the 
right-hand page will just barely become visible along 
the right edge of the window. 

~ Move the pointer to the 
bottom-left view button 
and click once to return 
to the page break, then 
again to return to where 
you started from. 

To zoom out, so that all pages in the drawing space are 
displayed together, 

~ Choose Reduce to Fit from the Page Layout menu. 

You will see an image like that in Figure 35. 
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~.---------

o;~'i .......... " .......... ~~O 

Figure 35. Reducing a Chart to Fit 

You can get back to the original size of the chart by 
choosing Show Actual Size from the Page Layout menu. 
You may be surprised by seeing nothing on your screen 
when you do this. If nothing appears, use the view button 
or other view controls to bring your chart into view. 

A partial reduction of the original can be obtained by 
choosing Reduce 70% from the Page Layout menu. You 
can choose Reduce 70% multiple times to get a smaller 
drawing. 

Filling the Available Space 

Now that your Schedule drawing space is enlarged, you 
can fill it up by moving the objects as shown in Figure 35. 
As you move objects, the arrows connecting them to 
adjacent objects will stretch to accomodate the move, 
always preserving the left-to-right order of the objects. 

To do this, 

~ Move the objects individually until your chart looks 
like Figure 36. 



Breaking Tasks 
into Sub tasks 

Figure 36. Filling the Available Space 

It is often useful to separate tasks into two or more 
subtasks, as when a task is composed of subtasks that 
are 

• Performed by separate resources. 
• Managed by separate people. 
• Funded by separate departments. 
• Subject to separate constraints. 
• Situated around an internal task review. 

For example, the "Product Research" task in the 
example you are working with is performed by two 
resources, Bob and Robin. It may be clearer if this task 
were broken into two separate tasks, each performed by 
a separate resource. 

To do this, 

~ Choose Show Actual Size from the Page Layout 
menu. 

~ Scroll the" Product 
Research" task box into 
view, if it is not already 
there. 

Pl"M~t 
Rese.~1?Jl1 

J..(j 
":'" 
I' 

Chapter 3 ::: 859 
Creating Large Charts ••• 



860 ••• Section 8 
: : : LisaProject Tutorial 

~ Move the pointer to the 
name" Robin" and click 
the mouse button twice 
to select it. 

~ Choose Cut from the 
Edit menu. The selected 
name disappears. 

~ Press the (Tab) key to 
select the duration field. 

~ Choose Cut from the 
Edit menu. The selected 
duration disappears. 

~ Draw a new box below 
the original one. 

P/~t' 
P.>:st::aJ"Cn 

·-------------------'---··-1 

l'l~'t 
~S~J't':/~ ._-----------------------_. 

'":" 

" 

Pl"J..~t' 
~S·~J');/7 

._----------------------.. 
500 1Q 

r 
.... ,." .... , 

60IJ 1Q 



~ Enter" Product 
Research" as the label 
for the new task. Press 
the (Tab) key and enter 
"Robin" as the 
resource. Press the (Tab) 
key again and enter "7" 
as the duration. 

RotJ1f1 ,7' 

~ Choose Reduce to Fit from the Page Layout menu. 

~ Draw arrows between the start milestone and the new 
task box, and between the new task box and the 
lower-right task box. 

Your chart should now look like Figure 37. 

Figure 37. Breaking Tasks into Subtasks 

Adding Milestones You can put milestones anywhere in a chart to represent 
such things as 

• Release dates 
• Due dates 
• Funding dates 
• Partial completion dates 
• Resource availabilitYJiates 

In your example, try changing the "Testing" task by 
breaking it into two subtasks and adding a milestone 
between them. 
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To do this, 

~ Move the pointer to the 
arrow connecting the 
"Testing" task, which is 
the upper-right task 
box, with the "stop" 
milestone and click the 
mouse button once to 
select the arrow. 

~ Choose Cut from the Edit menu. 

~ Cut the second arrow on the "Testing" in the same 
manner. 

~ Choose Show Actual Size from the Page Layout 
menu. 

~ Click the lower-right 
view button to bring the 
"Testing" box into view. 

resting 

~ Draw two task boxes to the right of the "Testing" task 
and select the middle box, as in Figure 38. 

E§jestlf7J} 

.----.. --.. ---~------.-
Judy JJ 

c:]c=J 
t=-l c=J 

Figure 38. Adding Task Boxes 



~ Choose Change Task to 
Milestone from the 
Customize menu. The 
selected task box is 
automatically converted 
to a milestone circle as 
in Figure 39. 

Testlf7.'j 

.}I.idy JJ 

Calendar ... 
Set Scheduled Dates ... 
Remove Scheduled Dates 

Display Dates ..• 

Change Task to MIlestone 
"' , '" " , , ,! ' " 

Figure 39. Changing a Task to a Milestone 

~ Change the text in these three objects so that it looks 
like Figure 40. 

fll"St Test 

Figure 40. Revised Text 

~ Choose Reduce to Fit from the Page Layout menu. 

~ Connect the objects with arrows as in Figure 41. You 
may have to move the "stop" milestone to the right a 
bit in order to draw an arrow to it. 
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Figure 41. Revised Arrows 

Schedule charts may have multiple milestones at the 
beginning or the end of the chart. Multiple milestones at 
the beginning would imply that several events have to 
occur before the project begins. Multiple milestones at 
the end of the project would imply that several events 
occur simultaneously upon completion of the project. 

You can create charts using nothing but milestones. The 
specification of tasks, together with their resources and 
durations, may be too time-consuming in the initial stage 
of a planning effort that is subject to substantial 
changes. 

Two types of rearrangement are sometimes 
advantageous in a chart: 

• Consolidation of tasks, to bring together tasks that are 
performed by the same resource . 

• Rearrangement of the entire chart, to increase its 
visual simplicity and readability. 

Consolidation of tasks by the same resource is the 
opposite of breaking tasks into subtasks, which was 
discussed above. Consolidation is advisable when there 
is no useful purpose served by differentiating the parts of 
the tasks. It has the advantage of showing a single bar for 
the task in the Resource chart, rather than showing 
several bars ordered according to the length of the task. 



Copying Charts 
to LisaDraw 

Rearrangement of the entire chart is always a good 
practice, if it is possible, since it increases the 
communication impact of the chart. Figures 42 shows the 
example chart after rearrangement. 

Figure 42. The Chart After Rearrangement 

You can copy charts created by LisaProject into 
LisaDraw. This makes it possible to include charts in 
other types of presentations, and to annotate and 
otherwise edit the chart. 

When copying charts, the Schedule chart, Resource 
chart, and Task chart need to be copied separately if you 
want all three. Copying only one will not automatically 
cause the other two to be copied. 

To copy the Schedule chart into LisaDraw, 

~ Choose Select All of Document from the Edit menu. 

~ Choose Copy from the Edit menu. This copies the 
chart onto the Clipboard. 

~ Put away or set aside the Schedule chart. 

~ Tear off a new piece of drawing paper from the 
LisaDraw stationery pad, name it, and open it. 

~ Select the location where you want to copy the chart. 

~ Choose Paste from the Edit menu. 

Now you can add text and other graphic enhancements 
to your chart with LisaDraw. 
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There are two things you can do to facilitate the printing 
of large charts: 

• Select a paper size larger than the standard 8-1/2 by 
11 inches . 

• Change the type size to cause a reduction in the overall 
size of the printed charts. 

Each of these is described below. 

Changing Paper Size 

To select a paper size, 

~ Choose Format for Printer from the File/Print menu. 

~ In the dialog box that comes up, change the paper 
size to a larger size. 

~ Change the paper in your printer to correspond to the 
paper size you just chose. 

~ Open Preferences and change the paper size. 

~ Choose Print from the File/Print menu. 

~ Click OK in the dialog box. 

Enlarging and Reducing Type Size 

You can use the Type Style menu to change the 
appearance of charts on the screen, whether or not you 
plan to print them. 

To enlarge or reduce the type size for printing, you need 
a dot matrix printer or a daisy wheel printer with 
different-size type faces such as 10, 12, and 15 pitch. 
Changing type style and type size is done separately for 
the Schedule, Resource, and Task charts. 

To do this, 

~ Choose Select All of Document from the Edit menu. 

~ Choose 10 pitch from the Type Style menu. The chart 
will be redisplayed in a larger size. 

~ Choose Preview Pages from the Page Layout menu. 

~ Choose Reduce to Fit from the Page Layout menu, 
and examine the resulting page layout after reduction. 
If necessary, move objects on Schedule charts to 
improve the page layout. 



~ If you are using a daisy wheel printer, change the print 
wheel to a 10 pitch print wheel. 

~ Open Preferences and specify the new print wheel. 

~ Choose Print from the File/Print menu. 

~ Click OK in the dialog box. 
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Enlarge drawing space 

Scroll in view-sized 
increments 

Zoom 

Fill available space 

Break tasks into 
subtasks 

Add milestones 

Rearrange chart 

• Choose Add Page Right 
or Add Page Bottom 
from the Page Layout 
menu. 

• Choose Preview Pages 
from the Page Layout 
menu. 

• Click the mouse button 
once on the view button. 

• Choose Reduce to Fit 
from the Page Layout 
menu. 

• Choose Show Actual Size 
from the Page Layout 
menu. 

• Move the right-most 
objects first. 

• Move other objects to fill 
the space. 

• Cut the existi ng arrows. 

• Draw new tasks boxes. 

• Enter the text. 

• Draw new arrows. 

• Draw a task box and 
select it. 

• Choose Milestone Circle 
from the Customize 
menu. 

I!! Enter the text. 

• Combine tasks that have 
the same resource. 

• Move objects to simplify 
visual appearance. 



Copy charts to LisaDraw 

Enlarge type size 

• Choose Select All of 
Document from the Edit 
menu. 

• Choose Copy from the 
Edit menu. 

• Get or activate the 
L isaDraw document. 

• Select the location for 
copying. 

• Choose Paste from the 
Edit menu. 

• Choose Select All of 
Document from the Edit 
menu. 

• Choose 12 or 10 pitch 
from the Type Style 
menu. 

• Choose Preview Pages 
from the Page Layout 
menu. 

• Choose Reduce to Fit 
from the Page Layout 
menu. 

• Open Preferences and 
specify the new print 
wheel. 

• Change print wheel in 
daisy wheel printer. 

• Choose Print from the 
File/Print menu. 
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• Choose Format for 
Printer from the File/ 
Print menu. 

• Specify new paper size in 
dialog box. 

• Open Preferences and 
specify the new paper 
size. 

• Change paper in printer. 

• Choose Print from the 
File/Print menu. 
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Applying LisaProject 

This chapter presents four relatively simple examples of 
Schedule, Resource, and Task charts, drawn from 
different industry applications. 

By getting these examples from the LisaProject 
Examples folder and experimenting freely with them, you 
will gain a feeling for manipulation of the various 
elements in different charts. 

No attempt is made to guide you step by step through 
this experimentation. This is simply an opportunity to 
practice the techniques you've learned in Chapters 1, 2, 
and 3 on complex charts that have already been created. 
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The example charts illustrated in this chapter are named: 

• Product Design Example. 
• European Distribution Example. 
• Construction Work Example. 
• Job Shop Example. 

Get these example charts from the LisaProject Examples 
folder. To do this, 

~ Open the ProFile window. 

~ Open the LisaProject Examples folder. 

~ Tear off a chart from one of the example stationery 
pads. 

~ Name the chart. 

~ Open the chart. 

El 

1/3183 

Product Design 
Ranger Mfg., Inc. 



European 
Distribution 
Example 

Construction Work 
Example 

El 

II!I Elli opean Dlstllblitlon III 

European Distribution for Bottles 

113/83 11.1.0/83 

ConfirM 
NNC'S Call 
PerforM 

.. !!:!~~!:~.~!£~~!.II. 

American Bottle Company 

1110183 1131183 

Define 
Distribution 

Role .-----_.----... _----_ ... 
sales A 15 

c..."..,,-=---:-2i1~':::!83 ~ 

1124183 1131'83 

Develop 
Legal Rider 
On X-Border 

.:':~~~~j.~!:~. 

111,1 1 Construction Work IIII 

Construction Work 

1131183 2/7183 

Assign 

A~i~i I ~~~p~~
........ ~~.:?p.~_ ..•....• 
sales 0 5 

Completing Ground Work and Utility Installation 
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Shepherd's Job Shop 
A Subsidiary Of Reilly's Inc. 
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What's in the 
LisaProject Reference Guide? 

This LisaProject Reference Guide contains complete 
information about LisaProject and is divided into two 
parts. Chapter 1 briefly explains basic LisaProject 
concepts. Read Chapter 1 for an overview of LisaProject 
and how to use it. Chapter 2 is divided into categories. 
Within each category there are directions for 
accomplishing specific tasks and some examples. Use 
Chapter 2 for step-by-step instructions on how to 
complete a particular task within LisaProject. 

You can look for specific topics in the Index, in the table 
of contents of this Reference Guide, or at the beginning 
of each category of Chapter 2 of this Reference Guide. 

The information in the LisaProject Reference Guide is 
based on the assumption that you have completed 
LisaGuide, for an introduction to the Lisa, and Section A, 
Getting Started with LisaProject, for a brief introduction 
to the basic skills needed to use LisaProject. For more 
self-paced instructions on LisaProject, you can use the 
LisaProject Tutorial, Section B. 

Cv 
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What's in 
Chapter 1? 

The LisaProject 
Screens 

Menu bar 

Document title 

SubTitle 

Milestone label 

Task resource 

Overview 

Chapter 1 covers the basic concepts and terminology in 
LisaProject. It introduces you to the LisaProject screens, 
selecting, drawing, entering text, and the LisaProject 
work flow. 

There are three screens or charts associated with each 
document. These include the Schedule chart, the 
Resource chart, and the Task chart. 

Schedule Chart 

The Schedule chart is shown in Figure 1. 

Task Menu item 

Figure 1. Schedule Chart 
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The following brief descriptions explain the functions of 
the items you see in Figure 1. 

Document title The title of the document 
that contains the Schedule, 
Resource, and Task charts. 
One LisaProject document 
has three different charts. 

Menu bar 

Icon 

Menu title 

Menu item 

Window 

Title 

SubTitle 

Task 

iviiiestone 

Shows the menus available 
in LisaProject. 

Graphic symbol 
representing something on 
the Lisa desktop. 

Shows the name of a list of 
menu items. 

An option, command, or 
instruction that affects the 
current selection when you 
choose it. 

Displays the contents of an 
open icon. 

An area at the top of the 
chart reserved for a title. 

An area at the top of the 
chart reserved for a 
subtitle. 

A box representing one job 
in the project, the 
resources that it takes to 
get the job done, and the 
time it takes for each 
resource. 

A circle representing an 
important event in the 
project; for example, the 
completion of a portion of 
the tasks. 



Arrow 

Task duration 

Task resource 

Task label 

Milestone label 

A straight line connecting 
tasks and milestones and 
defining tile relative order 
in which they must be 
completed. The priority for 
completing tasks and 
milestones always flows 
from left to right across the 
chart. 

The duration of a task, in 
working days. Nonworking 
days, such as weekends 
and holidays, are added 
automatically from 
LisaProject's internal 
calendar. 

The name of a person, 
equipment, vendor, or any 
facility that will be 
necessary to perform the 
task. A task may have more 
than one resource. 

The name of the task. 

The name of the milestone. 

Schedule charts can be multi-page. To see a multi-page 
chart, you need to either scroll through the pages or 
reduce the page layout so that the chart fits in a single 
screen display. 

Resource Chart 

The Resource chart is shown in Figure 2. This chart was 
generated automatically by LisaProject from the 
Schedule chart in Figure 1. You never create a Resource 
chart; LisaProject always does it for you. 
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Time line 

Figure 2. Resource Chart 

The following brief descriptions explain the functions of 
the items you see in Figure 2. 

Title An area at the top of the 
chart reserved for a title. 
The Resource chart may be 
named differently from the 
Schedule chart. 

SubTitle 

Time line 

Task 

An area at the top of the 
chart reserved for a 
subtitle. Like the chart title, 
this may be different for 
each chart. 

A set of dates associated 
with the thin vertical lines 
through the chart. The 
vertical divisions represent 
periods of 1, 2, 4, or 8 
weeks. 

A bar representing a task 
that was drawn on the 
Schedule chart. 



Task label 

Task duration 

Slack time 

Resource 

Current date 

The task label that was 
entered in the Schedule 
chart 

The length of a task bar 
representing the elapsed
time duration of the task. 
Nonworking days, such as 
weekends and holidays, 
that occur during the task 
are added to the duration 
entered in the Schedule 
chart to derive the elapsed
time duration of the task. 

The amount of time, if any, 
that the task completion 
may be late without 
affecting the completion 
time of the entire project. 
Tasks that have slack are 
not critical tasks. Those 
that have no slack are 
critical. 

The name of a person, 
equipment, vendor, or any 
facility that will be 
necessary to perform the 
task. 

A dark vertical line 
representing the date last 
entered in the calendar as 
the current date. 

In the Resource chart, tasks are grouped according to 
the resources that are used by them; within this group, 
they are sorted by early start time. 

Resource charts can be multi-page. To see a multi-page 
chart, you need to either scroll through the pages or 
reduce the page layout so that the chart fits in a single 
screen display. 
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Time line 

Task Chart 

The Task chart is shown in Figure 3. This chart was 
generated automatically by LisaProject. You never create 
a Task chart; LisaProject always does it for you. 

------------... --+--i----i----Exemple 1 

Slack time 
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Figure 3. Task Chart 

The following brief descriptions explain the functions of 
the items you see in Figure 3. 

Title An area at the top of the 
chart reserved for a title. 
The Task chart may be 
named differently from the 
Schedule or Resource 
chart. 

SubTitle An area at the top of the 
chart reserved for a 
subtitle. Like the chart title, 
this may be different for 
each chart. 



Time line 

Task 

Task label 

Task duration 

Slack time 

Resource 

Current date 

A set of dates associated 
with the thin vertical lines 
through ihe chart. The 
vertical divisions represent 
periods of 1, 2, 4, or 8 
weeks, and they are the 
same dates that appear in 
the Resource chart time 
line. 

A bar representing a task 
that was drawn on the 
Schedule chart. In the Task 
chart, tasks are sorted by 
early start time. 

The task label that was 
entered in the Schedule 
chart. 

The length of a task bar 
representing the elapsed
time duration of the task. 
Nonworking days, such as 
weekends and holidays, 
that occur during the task 
are added to the duration 
entered in the Schedule 
chart to derive the elapsed
time duration of the task. 

The amount of time, if any, 
that the task completion 
may be late without 
affecting the completion 
time of the entire project. 
Tasks that have slack are 
not critical tasks. Those 
that have no slack are 
critical. 

The name of a person, 
equipment, vendor, or any 
facility that will be 
necessary to perform the 
task. Tasks may have more 
than one resource. 

A dark vertical line 
representing the date last 
entered in the calendar as 
the current date. 
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Task charts can be multi-page. To see a multi-page 
chart, you need to either scroll through the pages or 
reduce the page layout so that the chart fits in a single 
screen display. 

LisaProject enables you to create a Schedule chart and 
then automatically obtain the associated Resource and 
Task charts. 

The Schedule chart is created by drawing tasks and 
milestones, entering resources and durations for each 
task, and connecting the tasks and milestones with 
arrows to show the priority of events. 

LisaProject calculates a schedule of dates for all tasks 
and milestones. You can override any of the dates that 
are calculated by entering "scheduled" dates. 

You may modify your drawing of tasks and milestones in 
the Schedule chart at any time. When you do, the 
Resource and Task charts will automatically change. 
Tasks and milestones are modified by first selecting 
them and then moving, stretching, shrinking, copying, or 
cutting them. You may also add pages to the Schedule 
chart to make a bigger chart. 

You may change the style of text in a chart; this is called 
formatting. Changing the content of text is called editing, 
which includes adding to, rearranging, replacing, and 
removing existing text. Before you may edit or format, 
however, you must select the text to be changed. 



Pointers 

As you move the mouse, the pointer moves around the 
screen. Depending on what you're doing, the pointer can 
have any of the following shapes: 

+ 

x 

Selecting 

The drawing pointer is used 
to d raw boxes and arrows 
in Schedule charts. 

The text pOinter appears 
whenever you can enter 
text. 

The arrow pointer is used 
for view controls, menu 
items, and selecting icons, 
tasks, milestones, and 
arrows. 

The check pointer is used 
to choose items within a 
dialog box or the 
Preferences window. 

The hourglass appears 
when you need to wait while 
the Lisa finishes what it is 
doing. 

You tell LisaProject that you want to work with an object 
by selecting that object. You can change the selection as 
often as you like. You can either select a single object or 
all of the document. 

Table 1 explains how to select things. A shaded outline 
shows that an object is selected. On task boxes or 
milestone circles that are selected, eight dark handles 
also appear on the outline. Text that is selected appears 
highlighted on the screen. 
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Table 1. Selecting in LisaProject 
------------------------------------~----------- ---
To Select 

Task box 

Milestone circle 

Task bar 

Arrow 

One or more characters 

Do the Followi ng 

• Move the pointer so that 
it touches the box. The 
pOinter changes to an 
arrow pOinter. 

• Click the mouse button; a 
gray outline with handles 
appears to show that the 
box is selected. 

• Move the pointer so that 
it touches the circle. The 
cursor changes to an 
arrow pOinter. 

• Click the mouse button; a 
gray outline with handles 
appears to show that the 
circle is selected. 

• Move the pointer inside 
the bar. 

• Click the mouse button; 
the bar becomes dark to 
show that it is selected. 

• Move the pointer so that 
it touches the arrow. The 
pointer changes to an 
arrow pOinter. 

• Click the mouse button; 
the line becomes gray. 

• Move the pOinter to the 
left of the first character. 

II Press and hold the 
mouse button. 

• Pull through to the last 
character and release the 
mouse button. 



Table 1. Selecting in LisaProject, continued 

To Select 

One word 

One line of text 

Text field 

Select everything 

Deselect; select nothing 
in the document 

Do the Following 

• Move the pointer to the 
word and cl ick the mouse 
button twice. 

• Move the pointer to the 
line and click the mouse 
button three times. 

• You may be able to use 
the (~) key as an 
alternative to clicking 
over the text field. 
Pressing the (Tab) key 
selects the next text field 
in a group of text fields. 
Pressing (Shift) and (Tab) 
together selects the prior 
text field. 

• Choose Select All of 
"""''-'-:-:'' ,._-.._ .......... J!.,.-. __ -. ... i-._ r-,-JI~..L 

UV¥';UIlIt::11L II VI i I lilt:; LUlL 

menu. 

• Click the mouse button in 
a blank area of the chart. 
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Scroll arrow 

View button 
Elevator 

Scroll bars 

View button 

Scrolling 

The window of the active document has view controls, 
shown in Figure 4, that you may use to bring hidden 
portions of the document into view. 

lQ 

1/3163 1110163 

Bob 

RObin I Proauct Researcn 

Ir : 
:i:i:im!!!:i:::i:i!i!i:i: iHiiliiiiWil Q I [II 

1117163 1/2~163 

LisaProiect Tutorial 

Example 1 

10eveiopMent 

1131163 

I 

Column width control I IElevator Scroll arrow I 
Figure 4. Window with View Controls 
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The following brief descriptions explain the functions of 
the items you see in Figure 4. 

Scroll arrows Enable you to bring hidden 
portions of a document into 
view in small increments. 

Column width control 

Elevators 

Scroll bars 

View buttons 

In the Resource and Task 
charts, enables you to 
adjust the width of the left
hand column where 
Resource or Task names 
are displayed. 

Indicate where the current 
view is in relation to the rest 
of the document. 

Contain controls that let 
you change the view of the 
document. 

Scroll the document one 
window at a time. 
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Table 2 shows the different ways to scroll in LisaProject. 

Table 2. Scrolling in LisaProject 

To Scroll 

In small increments 

Window-sized 
increments 

Continuous window
sized increments 

Large jumps 

About Menus 

Do the Following 

• With the pointer on the 
scroll arrow, press the 
mouse button and 
release it when the 
document is positioned 
where you want it. 

• Click on the view button. 

• With the pointer on the 
view button, press the 
mouse button and 
release it when the 
document is positioned 
where you want it. 

• With the pOinter on the 
elevator, move the 
elevator and release the 
mouse button when the 
document is positioned 
where you want it. 

Most of the operations that you can perform in 
LisaProject you do by choosing an item from a menu. 
The menus available are listed on the menu bar as shown 
in Figure 5. A description of all LisaProject menu items 
can be found in Appendix 1, Menu Items, in this manual. 

Customize [hart 

Figure 5. Menu Bar 



To choose a menu item, 

~ Move the pointer to the 
menu bar and position it 
over the name of the 
menu you want. 

~ Press the mouse button 
and hold it down. Notice 
that the menu is now 
showing. 

~ Move the pointer to the 
menu item you want. 

~ Release the mouse button. 

Task 

Some menu items have an Apple symbol and a letter 
beside them. This means that you can hold down the @ 
key and the letter to choose a menu item rather than 
choosing the item with the mouse. For a list of menu 
items that you can choose using the @ key, refer to 
Appendix 2, Apple Keys, in this manual. 

Some menu items are followed by an ellipsis ( ... ). When 
you choose one of these menu items, you must respond 
to a dialog box before the item takes effect. Dialog boxes 
are explained later in this chapter. 

When a menu item is shown in gray instead of black, it 
cannot be chosen at that time. This is usually because 
the menu item does not apply to the current selection. 

Some menu items are 
grouped together and 
represent the available 
choices for a particular 
menu setting. For example, 
in the Page Layout menu 
you can choose Don't 
Preview Pages or Preview 
Pages; the current setting 
has a check mark next to it, 
while the other one doesn't. 
If you choose another 
setting, the current one 
automatically turns off. 

../Oon't Preview Pages 
Previ ew Pages 

../Show Actual Size 
Reduce to 70% 
Reduce to Fit 

Add Page on Right 
Add Page on Bottom 
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Dialog Boxes 
_________________________ cc~~~~ __ 

A dialog box is a box that appears on the screen in 
response to certain menu items. It allows you to accept 
or change various options that apply to the command. A 
dialog box for LisaProject is shown in Figure 6. 

r- File/Print Edit Type Style Page layout [ustomize [hart 

Start task no earl ier than: -Finish task no later than: ASAP ( OK ) 

Figure 6. LisaProject Dialog Box 

To fill in a dialog box, 

~ For each option that you wish to change, check the 
box next to the option you want by moving the pointer 
to the box and clicking the mouse button. 

~ When the dialog box reflects the options you want, 
click OK. 

~ If you change your mind and decide not to perform 
the operation called for by the menu item, click 
Cancel. 

Alert Boxes 

An alert box is a box in which a message from the Lisa is 
displayed. The message can be Wait, Note, Caution, 
Stop, or ?, as described below. You can usually respond 
to these messages by clicking the OK or Cancel button. 
To do this, move the pOinter to the OK or Cancel button 
and click the mouse button. 

Wait Message 

The Wait message tells you that your Lisa is carrying out 
an operation that may take some time. You don't need to 
respond to a message of this type. However, some Wait 
messages give you the option of being able to terminate 
the operation by holding down the @ key while typing a 
period. Figure 7 is an example of a Wait message. 



lisa is creating a new document from "lisaProject 
Paper" on "ProFile". 

To terminate the operation, hold down the Rpple key 
while you type a period. 

Figure 7. Wait Message 

Note Message 

The Note message tells you that something might need 
your attention. Most likely, everything is all right, but the 
Lisa wants to tell you about something just in case. To 
dismiss the alert box with a Note message, you just click 
OK. Figure 8 is an example of a Note message. 

"sjm [hI" has not been changed since it was 
I ast put away. 

Figure 8. Note Message 

Caution Message 

OK 

The Caution message tells you that you are about to do 
something risky that cannot be undone or something 
that may take a long time. To dismiss the alert box with a 
Caution message, you click OK or Cancel. Figure 9 is an 
example of a Caution message. 

Do you really want the active document to 
revert to the version saved 1 minute ago? 

To leave the document as it is now, 
click Cancel. 

Once you click OK, you will not be able 
to change your mind, even by choosing 
Undo. 

Figure 9. Caution Message 

Cancel 

OK 
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Stop Message 

The Stop message tells you that something you 
requested cannot be done and why. To dismiss the alert 
box with a Stop message, you click Cancel. Figure 10 is 
an example of a Stop message. 

( Cancel 

Before you Cut, make a selection. 

Figure 10. Stop Message 

?Message 

The? message tells you that you can choose one of a 
number of alternative actions. Most? messages have 
two or three choices. You dismiss the alert box with a ? 
message by clicking on one of the choices. Figure 11 is 
an example of a ? message. 

If you want to Finish this duplication, you 
must move the duplicate(s) beFore you do 

(once I 

anything else. ( Continue 

Figure 11. ? Message 



Dates 

Figure 12 shows the dates that are displayed for tasks 
and milestones. 

Early start Early s~ ~ finish 

1./3/83 J,.l1'/83 

Late finish 

(':5 
Lates:r-

Milestone Task 

Figure 12. Display Format for Dates 

Each milestone has two dates: early start on top, late 
finish on the bottom. Each task has four dates: early start 
and early finish on top, late start and late finish on the 
bottom. 

To have dates actually displayed on the screen, you also 
need to choose Display Dates from the Customize menu. 

For details about dates, see the Date procedures in 
Chapter 2 of this Reference Guide. 
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Critical Tasks 

When you add arrows to a Schedule chart that has the 
dates turned on, dark outlines appear around certain 
tasks and milestones. This illustrates the critical tasks. 

Critical tasks are those that have no slack time. They are 
tasks that must be finished on time if the entire project is 
to be finished in the earliest possible time. The sequence 
of critical tasks forms the longest time path through the 
project. This path is critical either because its tasks have 
long durations or the tasks use resources which are 
shared with other tasks in the project. 

By contrast, a task that is not critical may take longer, up 
to the limit of its slack time, with no effect on the overall 
project completion time. 



LisaProject 
Work Flow 

The following sections outline how to start a new 
LisaProject document and how to work with an existing 
LisaProject document. For specific information and step
by-step instructions, refer to Chapter 2 of this Reference 
Guide and Section D, Desktop Manager Reference 
Guide, in the Lisa Owner's Guide. 

Starting a New Document 

To start a new LisaProject document, 

~ Open the ProFile 
window. 

~ Tear off a sheet of paper 
from the LisaProject 
stationery pad. 

~ Type the new 
document's name. 

!J;N 
LlSaPrOJect paper 

I 
FOw~I~~ 

llsaPrO,Ject paper 

~ Open the new document's window. 

~ Enter tasks, dates, and other information to create 
your LisaProject charts. 

~ Save all changes about 
every 15 minutes and 
continue working. 
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~ Print the document, if 
you like. 

~ Put away the completed 
document. 

To organize your document into a folder and to keep the 
disk window uncluttered, you might want to 

~ Move the saved 
document into a folder 
of related documents, or 
tear a folder from the 
folder pad, name the 
folder, and move the 
document into it. 

Ii] 
FOLDER 



Working with an Existing Document 

To work with a filed LisaProject document, 

~ Open the ProFile 
window. 

~ If the document is in a 
folder, open the folder 
that contains the 
document that you want 
to work with. 

~ Open the document. 

.. 
~ Edit and format the document, saving it every 15 

minutes. 

~ Print the document, if you like. 

~ Put away the document in its original location. 
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What's in 
Chapter 21 

Procedures 

Chapter 2 contains procedures for using all the features 
of LisaProject. To make the procedures easier to find, 
they have been divided into categories according to 
function. The categories are: 

Date 

Look here to learn how to enter dates, in all their forms. 

C32 Display Dates 
C34 Enter Calendar Dates 
C36 Enter Scheduled Dates 
C39 Enter Work Days Remaining 

Draw 

Look here to learn how to draw all the objects used in 
LisaProject. 

C42 Arrows 
C44 Milestone Circles 
C45 Task Boxes 

Edit 

Look here to learn how to change the content of your 
chart. 

C48 Copy 
C49 Cut 
C50 Insert Object Labels 
C51 Insert Task Durations 
C52 Insert Task Resources 
C53 Insert Titles 
C54 Move Objects 
C55 Revert to Previous Version 
C56 Stretch/Shrink Objects 
C57 Undo Last Change 
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Format 

Look here to learn how to work with the arrangement and 
layout of your charts. 

C60 Add/Remove Pages 
C62 Reduce/Expand Document 
C63 Specify Time Scale 
C64 Type Styles 

Print 

Look here to learn how to print your charts. 

C6a Format for Specific Printers 
C73 Preview Chart 
C74 Print Chart 

Other Tools 

Look here to learn how to use LisaProject with other 
tools. 

cao LisaDraw 



C32 Display Dates 
C34 Enter Calendar Dates 
C36 Enter Scheduled Dates 
C39 Enter Work Days Remaining 

Date 

Chapter 2 ::: I C31 
Procedures •• • 



Date 

Display Dates 

• • • LisaProject Reference Guide 
C321 : : : Section C 

To turn on or turn off the display of dates on the 
Schedule chart 

~ Choose Display Dates 
from the Customize 
menu. A dialog box 
appears. 

Calendar ... 
Set Scheduled Dates ... 
Remove Scheduled Dates 
Display Dates... [.~ 

nm~~ Sfnle '" 
D{l~Js riemnininfJ ,., 

Change Task to Mi lestone 

~ Check the dates you want to see displayed. 

Ear I Y Start D On • Off 

late start D On • Off 

~ Click OK. 

Early Finish 0 On • Off 

late Finish 0 On • Off 

[ OK J 



The following dates can be displayed: 

Early Start: The earliest possible time a task or 
milestone will start, given the early finish dates of 
preceding tasks or milestones. 

Early Finish: The earliest possible time a task will finish, 
given the early finish dates of preceding tasks or 
milestones. Since milestones have no duration, their 
early start and early finish dates are the same. 

Late Start: The latest possible time a task will start, 
given the late finish dates of following tasks or 
milestones. 

Late Finish: The latest possible time a task or milestone 
will finish, given the late finish dates of following tasks or 
milestones. Since milestones have no duration, their late 
start and late finish dates are the same. 

Date 

Display Dates 
(continued) 
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To enter dates that LisaProject can use for schedule 
calculations 

~ Choose Calendar from 
the Customize menu. A 
dialog box appears. 

Set Scheduled Dotes • II 
Remove Scheduled Dates 
Display Dates II. 

~ Select and enter the two-digit calendar start year, and 
press the (Tab) key. 

Calendar: from January 1 19 _ 
to December 31 19 83 

Working Days per Week: 

Current day of project: 

Holidays: 
mm/dd/yy 
mm/dd/yy 
mm/dd/yy 
mm/dd/yy 

mm/dd/yy 
mm/dd/yy 
mm/dd/yy 
mm/dd/yy 

mm/dd/yy 

mm/dd/yy 
mmlddlyy 
mm/dd/yy 
mm/dd/yy 

mm/dd/yy 
mm/dd/yy 
mm/dd/yy 
mmlddlyy 

mmlddlyy 
mm/dd/yy 
mm/ddlyy 
mm/dd/yy 

~ Enter the calendar end year, and press the (Tab) key. 

~ Enter the days of work per week, and press the (Ta~) 
key. 

~ Enter the current date, and press the (Tab) key. 

~ Enter the first holiday during the project period, if 
there is one, and press the (Tab) key to enter any 
additional holidays. 

~ Click OK. [_OK_.J 



The first two entries in the calendar specify only the start 
and end years of the calendar for your project, not the 
actual start and end dates. 

Unless you schedule a different early start date for the 
first task or milestone in the project, LisaProject will 
assume a project start date of January 1 for the year 
specified in the calendar, although January 1 is not 
always the first working day of the year. See the Enter 
Scheduled Dates procedure, under Date, in this chapter. 

Your entry for days per week is interpreted as follows: 

Days Per Week 

5 
6 
7 

Working Days 

Mon-Fri 
Mon-Sat 
Mon-Sun 

If a holiday falls on a nonworking day, as determined by 
your days per week entry, then that holiday has no effect 
on scheduling calculations. 

When you enter calendar dates, LisaProject calculates 
the early start, early finish, late start and late finish dates 
for each task, based on their durations, dependencies, 
and resources required. LisaProject also calculates the 
early start and late finish dates for each milestone, based 
on the dependencies of the milestone. 

If you change the calendar information, the dates on your 
charts may also change, since the chart dates are 
recalculated based on the new calendar dates. 

To have dates displayed on the screen, you also need to 
choose Display Dates from the Customize menu. 

Date 

Enter 
Calendar Dates 

(continued) 
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To enter your own dates for a task or milestone, thereby 
overriding the dates calculated by LisaProject 

~ Select the task or milestone you want to schedule. 

~ Choose Set Scheduled 
Dates from the 
Customize menu. A 
dialog box appears. 

Remove Scheduled Dates 
Display Dates I .. 

~ Select and enter the dates you want to schedule. 

Start task no earlier than: 

Finish task no later than: ASAP 
( OK ) 

~ Click OK. 
[ OK J 

To change or delete a scheduled date 

~ Choose Set Scheduled Dates from the Customize 
menu. 

~ Set dates in the format 

mm/dd/yy 



A special feature of the Lisa allows you to set the 
scheduled late finish date of the end or stop milestone in 
the mm/dd/yy format or with ASAP. 

Scheduled dates are dates that you enter. They override 
dates that LisaProject has calculated and displayed. 

Scheduled dates appear as underlined dates in the 
Schedule chart. When scheduled dates are entered, they 
replace the prior dates and all subsequent dates are 
recalculated. 

If you enter a scheduled date that is impossible to 
achieve, given the calendar, task durations, and any 
oiher scheduled dates you've entei"ed, UsaProject win 
override it. 

The Display Dates procedure describes the manner in 
which early and late dates are calculated. Basically, the 
early dates are linked together and, separately, the late 
dates are linked together. The early dates are determined 
by the early start of the first task or milestone in the 
project, the durations of the tasks that follow, and any 
constraints imposed by resource competition. Similarly, 
the late dates are determined by the late finish of the last 
task or milestone, the durations of the tasks that precede 
it, and any resource competition. 

Because early and late dates are more or less separate 
from one another, it is possible to schedule a late date 
that is inconsistent with early dates, and therefore end up 
with a task that has an early start later than a late finish. 
This means that given all the constraints, the task must 
be finished before it is started, thereby showing that the 
schedule is impossible to meet. 

Date 

Enter 
Scheduled Dates 

(continued) 
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Enter 
Scheduled Dates 
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If you try to schedule an early date that is inconsistent 
with some other early date that occurs before it, 
LisaProject will simply not accept the entry and will use 
its own calculation instead. 

The late finish date for the last task or milestone in the 
project is assumed to be ASAP, which means as soon as 
possible, unless you schedule it differently. Your entry for 
this date is interpreted as follows: 

ASAP: LisaProject calculates the date based on task 
durations. Critical tasks are highlighted with darkened 
outlines in the Schedule chart. 

A finish date of ASAP, which means as soon as possible, 
means that LisaProject will calculate the earliest finish 
date possible. 

Scheduled date: LisaProject uses the late finish date 
you enter to calculate slack times for all preceding tasks. 
If the late finish date is later than the ASAP date, all tasks 
have slack and thus none is critical. If the late finish date 
is earlier than the ASAP date, some tasks will have late 
dates that occur before early dates. The difference 
between the late dates and the early dates indicates that 
the schedule can't be met; it also indicates how far 
behind the project is. 

For more information on scheduled dates, see Appendix 
5, LisaProject Scheduling, in this manual. 



To enter work days remaining for a task 

~ Choose Resource from 
the Chart menu. 

~ Select the task bar that you want to update. 

~ Choose Days Remaining 
from the Customize 
menu. A dialog box 
appears. 

(alendar ... 
Set Schedul ed Oates .•. 
Remove Scheduled Dotes 
f.'l;s~)!nu Dates ", '. 

Time Scale ... 

~ Enter the work days remaining. 

Days remaining in task: II 

~ Click OK. 
[ OK ] 

Date 

Enter Work Days 
Remaining 
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Enter Work Days 
Remaining 
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Your entries for work days remaining affect the shading 
of task bars on the Resource chart: the heavy shading on 
the left side of the task bars represents the work 
completed. The white area still represents work 
remaining, and slack time, if any is still shown, in light 
shading on the right side of the bars. 

If any task bar has white area (work remaining) to the left 
of the dark vertical line that represents the current date, 
that task is behind schedule. 



C42 Arrows 
C44 Milestone Circles 
C45 Task Boxes 

Draw 
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To draw an arrow 

~ Move the pointer inside 
the left-hand (origin) 
object, then press and 
hold the mouse button 
down. 

~ Move the pointer to the 
right-hand (destination) 
object and release the 
mouse button. 



An arrow signifies that the origin task or milestone must 
be finished before the destination task or milestone can 
be started. 

Any task or milestone can have multiple preceding or 
succeeding tasks or milestones. 

If you begin to draw an arrow and decide you don't want 
it, just back up to the origin object or to any pOint in the 
blank drawing area and release the mouse button. The 
arrow will disappear. 

Arrows can only be drawn from left to right. If you try 
drawing one from right to left, the following alert box will 
appear: 

( (once I 

Draw arrows from left to right. 

If this happens, first cancel the alert then move the 
objects you are trying to connect so that a left-to-right 
arrow can be drawn. 

Draw 

Arrows 
(continued) 
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Draw 

Milestone Circles To draw a milestone circle 

~ Draw a task box. 
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~ Select the task box. 

~ Choose Change Task to 
Milestone from the 
Customize menu. 

[alendar ... 

Set Scheduled Oates ... 
Remove Scheduled Oates 

Display Oates ... 

A milestone signifies an event that has no time duration 
and uses no resources. 

You can adjust the position and size of a milestone circle; 
see the Move Objects and Stretch/Shrink Objects 
procedures, under Edit, in this chapter. 



To draw a task box 

~ Move the pointer to where you want one of the 
corners of the box, then press and hold the mouse 
button down. 

~ While holding the mouse 
button down, move the ~ 
pointer diagonally until 
the box is as large as you 
want it, then release the 
mouse button. 

You can continue to change the shape of the box until you 
release the mouse button. 

Draw 

Task Boxes 
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C48 Copy 
C49 Cut 
C50 Insert Object Labels 
C51 Insert Task Durations 
C52 Insert Task Resources 
C53 Insert Titles 
C54 Move Objects 
C55 Revert to Previous Version 
C56 Stretch/Shrink Objects 
C57 Undo Last Change 

Edit 
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Copy 
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To copy task boxes, milestone circles, or text within the 
same document 

~ Select the object or text that you want to copy. 

~ Choose Copy from the 
Edit menu. 

Select A" of Document etA 

~ Select the new location for the object or text 

~ Choose Paste from the Edit menu. 

Copying differs from cutting in the following way: with 
copy, the selected object remains in your original chart, 
whereas with cut the selected object is erased. In both 
cases, however, the object appears on the Clipboard. 

By choosing Seiect Aii of Document from the Edit menu 
before you copy, your entire chart will be copied to the 
Clipboard. This can be used to transfer charts between 
LisaProject and LisaDraw. See the LisaDraw procedure, 
under Other Tools, in this chapter. 



To delete objects or text 

~ Select what you want to delete. 

~ Choose Cut from the 
Edit menu. 

Paste 

Select All of Document eiR 

When you cut an object or text, it is moved to the 
Clipboard, where it stays until you do another cut or copy. 

You cannot cut when you have chosen Select All of 
Document from the Edit menu. To delete an entire 
document, close it and move it to the Wastebasket. 

Edit 

Cut 
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To label a task or milestone 

~ Select the area in the task box or milestone circle that 
is reserved for the label. 

~ Enter the label. 

The area reserved for the task label is in the upper half of 
the task box. 

The area reserved for the milestone label is in the center 
of the milestone circle. 

Multi-line labels can be created by entering the first line 
of the label, pressing the (Return) key, and continuing with 
the entry. 



To enter a duration for a task 

~ Select the duration area of the task box. 

~ Enter the duration. 
Pl~'t 
Res~').,~ 

---------------------------

The area reserved for the duration is in the lower half of 
the task box, on the right-hand side. 

You can select the duration area of a task box either by 
moving the pointer to it and clicking twice or by pressing 
the (Tab) key when the resource label is selected. 

Edit 

Insert Task 
Durations 
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To enter a resource name for a task 

~ Select the area in the task box that is reserved for 
resource names. 

~ Enter the resource 
name. PJ~t 

RtJs~-cn 

----------------------------
6vtJ1 

The area reserved for the resource names is in the lower 
half of the task box, on the left-hand side. 

More than one resource can be associated with a single 
task. To enter multiple resources and durations, use the 
(Return) key to create new lines after a duration is 
entered. 

You can select the resource area of a task box either by 
moving the pointer to it and clicking twice or by pressing 
the (Tab) key when the task label is selected. 



To insert a title or subtitle on a chart 

~ Select the title or subtitle area on the chart. 

~ Enter the new text. 

The areas reserved for title and subtitle text are the two 
I ines at the top of the chart labeled "Title" and 
"SubTitle." You can tell when the pointer is over one of 
these areas because it appears like an I-beam. 

Edit 

Insert Titles 
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To move a task box or milestone circle 

~ Move the pointer to the 
outline of the object to 
be moved, then press 
and hold the mouse 
button. 

~ While holding the mouse 
button down, move the 
pOinter. A ghost of the 
object will follow the 
pOinter. 

~ When the object is in the desired location, release the 
mouse button. 

The pointer can be on any side of the object's outline in 
order to move the object in any direction, but do not let 
the pointer touch one of ~he eight darker handles on the 
outline. 

If you try to move an object to the right of succeeding 
objects, or to the left of preceding objects in a network, 
and if there is room on the page, LisaProject will 
automatically move the succeeding or preceding 
objects. 



To cancel all changes made to a document since it was 
last saved or put away 

~ Choose Revert to 
Previous Version from 
the File/Print menu. 

- . 
Set Aside Everything 
Set Aside "Untitled" 

Save & Put Away 
Seve & Continue 
Revert to Pre vi ou~ Ver~ion r. 

Format for Printer, .. 

Print '" 
Monitor the Printer .. , 

Edit 

Revert to 
Previous Version 
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Stretch/Shrink 
Objects 
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To stretch or shrink a task box or milestone circle 

~ Select the object. 

~ Move the pointer so that 
it touches any of the 
eight dark handles, then 
press and hold the 
mouse button down. 

~ Move the pointer to 
stretch or shrink the 
object. 

'11111111 11111 11111"1111"""11""1111'111' 1111111' f 
{--------------------------t 

il 
'1 ... w ..... wlN ••• w •• ,.w'flH'"y.y.YmIJlMNh.~ 

~ When the object is the desired size, release the 
mouse button. 

On task boxes, you can change the width, the height, or 
both simultaneously. To change only the width, use a 
handle in the middle of either side of the box. 

To change only the height, use a handle in the middle of 
the top or bottom of the box. 

To change both the width and the height simultaneously, 
use one of the corner handles. 



To undo the last change 

~ Choose Undo Last 
Change from the Ed it 
menu. 

Cut .x 
Copy .c 
Paste .v 
Select All of Oocument .A 

Edit 

Undo Last 
Change 
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C60 Add/Remove Pages 
C62 Reduce/Expand Document 
C63 Specify Time Scale 
C64 Type Styles 

Format 
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Format 

Add/Remove 
Pages 
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To add a page to the right of your chart 

~ Choose Add Page on 
Right from the Page 
Layout menu. 

To add a page to the bottom of your chart 

~ Choose Add Page on Bottom from the Page Layout 
menu. 

To remove blank pages from the bottom or right side of a 
Schedule Chart 

~ Choose Save & Put Away from the File/Print menu. 



The Page Layout menu applies only to the Schedule 
chart. Adding a page to the Schedule chart will not add a 
page to the Resource or Task chart. 

When you add a right page to a chart which has already 
had a bottom page added, a page will automatically be 
added to fill in the lower-right corner. 

First 
Add 

Page 
Right 
Page 

Add 
Bottom 
Page This page is automatically 

added if both a right page 
and a bottom page are added. 

Normally, page edges are not displayed, although they 
can be. See the Preview Chart procedure, under Print, in 
this chapter. 

During printing, each page of a multi-page chart is 
printed separately. You can then tape them together or 
pin them to a wall. 

You have to put your chart away to remove blank pages 
on the bottom and right side of a Schedule chart. When 
you open the chart the next time, the blank pages will 
have been discarded. 

Format 

Add/Remove 
Pages 

(continued) 
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To reduce the displayed size of a document so that all 
pages in the drawing space are displayed together 

~ Choose Reduce to Fit 
from the Page Layout 
menu. 

"'Don't Previ ew Pages 

Preview Pages 

"'Show Actual Size 
Reduce to 70% 
Reduce to Fit ~ 

Add Page on Right 

Add Page on Bottom 

When a document is reduced to fit, all controls in the 
scroll bars are inactive 

To reduce the displayed size of a document to 70% of its 
cu rrent size 

~ Choose Reduce to 70% from the Page Layout menu. 

To display the document in its original size 

~ Choose Show Actual Size from the Page Layout 
menu. 

If you have chosen Reduce to Fit and then you want the 
70% size, first choose Show Actual Size and then choose 
Reduce to 70%. 



To specify the time scale for Resource and Task charts 

~ Choose Resource from 
the Chart menu. 

~ Choose Time Scale from 
the Customize menu. A 
dialog box appears. 

[alendar ... 
Set Scheduled Dates ... 
Remove Scheduled Dates 
fHsplny fJ(.~tes 

~ Check the number of weeks you want each vertical 
division in the Resource and Task charts to represent. 

Scale: 

• 1 week D 2 week D 4 week D B week 

~ Click OK. ( OK ) 

Format 

Specify 
Time Scale 
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To change the type style of all task and milestone text 

~ Choose Select All of 
Document from the Edit Undo last Change 
menu. 

~ Choose a type style from 
the Type Style menu. 

[ut 
[opy 

Paste 

Underline 
Bold 
Italic 

tiP 
tiu 
ti8 
til 

15 Pitch Gothic 
12 Pitch Modern 
12 Pitch Elite 
10 Pitch Modern 
10 Pitch Courier 
PS Modern 
PS Executive 
1/4 Inch Modern 
1/4 Inch [lassie 
1/3 Inch Modern 
1/3 Inch [lassie 

tix 
ti[ 
tiv 



To change the type style of individual lines, words, or 
characters in the title or subtitle areas 

~ Select the line, word, or character. 

~ Choose a type style from the Type Style menu. 

New text that you add to your chart will be in the "plain" 
text style until you change it. 

When you select a new type style, LisaProject reduces or 
expands the Schedule task boxes and milestone circles 
to accommodate the size of the new type style. 

You can, therefore, reduce or expand the size of your 
charts by reducing or expanding the size of the type in 
the charts. 

For example, the normal type size for LisaProject charts 
is 15 pitch, which prints 15 characters per inch. By 
changing to the 10-pitch type size, 10 characters per 
inch, you expand the size of the chart. 

To change the type size for printing, you need a dot 
matrix printer or a daisy wheel printer capable of printing 
in different type sizes. See the Format for Specific 
Printers procedure, under Print, in this chapter. 

Format 

Type Styles 
(continued) 
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C68 Format for Specific Printers 
C73 Preview Chart 
C74 Print Chart 

Print 
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Format for 
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To format your document for a specific printer 

~ Choose Format for 
Printer from the File/ 
Print menu. 

Monitor the Printer ... 

~ Check the type of printer that this document will 
print on. 

~ If you are using a dot matrix printer, check the 
orientation and resolution that you want to use for this 
document. 

~ If you are using a daisy wheel printer, check the paper 
size and print wheel style that you want to use for this 
document. 

~ Check the response you want the Lisa to make if no 
printer matches the settings you've picked. 

~ Click OK. [ OK J 



The settings you check in the Format for Printer dialog 
box work with the formats you set in your document as 
you enter and edit text. These printer settings are saved 
with each document, and become part of the settings 
that determine how your document displays on the 
screen, as well as how it prints out. 

It's a good idea to choose the Format for Printer settings 
for a document before you add other formats to your 
document, because some Format for Printer settings 
limit the other formatting settings available to you. 

These are discussed under the individual settings below. 

Printer format settings take effect in the text of your 
document after you click OK in the dialog box. 

Settings in the Format for Printer Dialog Box 

The Format for Printer dialog box lets you check the kind 
of printer you want this document to print on, and then 
lets you specify some details on size of paper and type 
style. 

You can tell the Lisa to print your document on a dot 
matrix or daisy wheel printer. The items that follow Print 
Method in the dialog box change when you change your 
printer preference from dot matrix to daisy wheel, or 
back. 

Print 

Format for 
Specific Printers 

(continued) 
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Format for 
Specific Printers 
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Dot Matrix Printer Settings 

When you choose Dot Matrix printer in the Format for 
Printer dialog box, you see these additional choices: 

Format For Printer ... 
On which printer do you intend to print this document? 

Print Method:. Dot Matrix 0 Daisy Wheel 
Paper Length:lll" 0 14" 
Orientation: IPortrait (tall) o Landscape (wide) 
Resolution: • Normal o High 

What do you want done if the printer you've specified 
does not appear to be connected to this machine? 

Orell Me .Pick an Available Printer for Me ODisregard it 

Paper Length: With a dot matrix printer, you can print 
on 11 or 14 inch paper. 

Orientation: This setting tells the Lisa whether to print 
your document horizontally or vertically on the paper in 
your printer. When the orientation is Landscape, your 
Lisa treats the length of the paper, whether it is 11 or 14 
inches as the width. In other words, it treats the paper as 
though it could turn it on its side before printing. 

Resolution: This tells your Lisa what quality you want the 
document to print with. Normal resolution gives you a 
standard character image. High resolution produces a 
much finer quality character image, but takes longer to 
print. 

When using landscape orientation and normal 
resolution, the font size of the text will be smaller when it 
is printed than it was shown on the screen. in order to 
print the largest portion of your chart on the smallest size 
of paper, use landscape orientation, normal resolution, 
and 15 pitch. 



Daisy Wheel Printer Settings 

When you choose Daisy Wheel printer in the Format for 
Printer dialog box. you see these additional choices: 

FDrmat FDr Printer .. , 
On which printer do you intend to print this document? 

Print Method: 0 Dot Matrix • Daisy Wheel 
Paper Size: IS.5xll" 0 llxS.5" 

o S.5x 14" D 14xS.5" D 14x 11" 
Print Wheel: 015 Piton .12 Pitch 010 Pi tch OExecutive 

o fl..!ulti-Font 0 Multi-Pi t ch 0 Lisa Complete 

What do you want done if the printer you've specified 
does not appear to be connected to this machine? o Tell Me • Pick an Available Printer for Me 0 Disregard it 

Paper Size: When you print with a daisy wheel printer, 
you have five choices for paper size: 8- i 12 xii inches; i i 
x 8-1/2 inches; 8-1/2 x 14 inches; 14 x 8-1/2 inches; and 
14 x 11 inches. 

Print Wheel: You have a range of choices in print wheels. 
The wheel you decide to use does limit the range of type 
styles and fonts that you may use in your document. For 
instance, if the print wheel you choose does not contain 
italic characters, italics will not display in the text of your 
document. When you try to use a type style or font that is 
incompatible with the current printer settings, you'll see 
an alert box. 

When Settings Don't Match a Printer: In order for the 
Lisa to follow your instructions in this Format for Printer 
dialog box, two other factors must be true: Preferences 
must show that the type of printer with the settings you 
choose here is attached to your Lisa, and such a printer 
must be attached. 

Whenever you click OK in the Format for Printer dialog 
box, the Lisa checks the new settings against the printer 
settings listed in Preferences. If they don't match, your 
Lisa then looks at the bottom line of the dialog box to see 
what you want done. 

Print 

Format for 
Specific Printers 

(continued) 
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Tell Me: When Tell Me is checked, your Lisa notifies you 
that no printer specified in Preferences meets the 
settings you have checked. An alert box appears, so that 
you can decide what you want to do next. Here is what it 
looks like: 

Intended Printer Unavai lable! 
According to the Preferences Window's list of Device Connections, the 
Intended Printer for this document is not connected to this machine. 

On which printer do you intend to print this document? 
o A printer that is not listed in Preferences right now . 
• Slot 2 Upper -- Dot Matrix -- 11" 

What do you want done if the printer you've specified 
does not appear to be connected to this machine? OK 

.Tell He 0 Pick an Available Printer for He 0 Disregard it 

Pick an Available Printer: When Pick an Available 
Printer is checked, the Lisa will choose an alternative 
printer if one doesn't match the settings you requested 
exactly. For instance, if you've specified a daisy wheel 
printer but only a dot matrix is attached and checked in 
Preferences, your Lisa formats your document for the 
dot matrix printer, rather than for a daisy wheel printer. 

Disregard It: When Disregard It is checked, the Lisa 
notes the difference in printer settings and available 
printers, but doesn't do anything. This allows you to 
continue working with your document without being 
interrupted to make a decision about print formats now. 
You should check this box when you intend to print the 
document on a different printer from the one that is 
connected to your Lisa now. 



To preview a document 

~ Choose Preview Pages 
from the Page Layout 
menu. 

To cancel 

~ Choose Don't Preview Pages from the Page Layout 
menu. 

Preview shows you how your document will look when 
printed, based on the current printer specifications and 
the current page layout settings. 

When you choose Preview Pages, the current view of your 
document doesn't change. You can use the view controls 
to see the rest of your text. 

You may enter, edit, and format text while preview is on, 
just as at any other time while using LisaProject. 

Print 

Preview Chart 
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To print a chart 

~ Make sure your printer is set up and connected to 
your Lisa. For assistance, see the manual that came 
with your printer. 

~ If you have not previously specified the printer you use 
in Preferences, do so now. For assistance, refer to 
Section D, Desktop Manager Reference Guide, in the 
Lisa Owner's Guide, under Set Printer Configuration. 

~ Get or activate the document. 

~ If you need to change 
any of the options in 
Format for Printer dialog 
box for this chart, 
choose Format for 
Printer from the File/ 
Print menu. 

Monitor the Printer 

~ Make any necessary changes in the Format for Printer 
dialog box that appears. 
Format For Printer ... 

On which printer do you intend to print this document? 
Print Method:. Dot Matrix 0 Daisy Wheel 
Paper Length: Ill" 0 14" 
Orientation: I Portrait (tall) 0 Landscape (wide) 
Resolution: • Normal 0 High 

What do you want done if the printer you've specified 
does not appear to be connected to this machine? o Tell Me • Pick an Available Printer for Me 0 Disregard it 



~ Click OK. 

~ Choose Print from the 
File/Print menu. 

OK 

~ Make any necessary changes in the Print dialog box 
that appears. 

~ Click OK. 
OK 

Using the current printer settings and the formats you 
specified in the text, your document begins printing. 

For how to make changes in the Format for Printer dialog 
box, see the Format for Specific Printers procedure, 
under Print, in this chapter. 

If the printer settings and printer don't match, an alert 
box appears. Alert boxes resulting from a mismatch are 
discussed in the Format for Specific Printers procedure 
in this chapter. 

Sometimes a dialog box titled Monitor the Printer will 
appear. See While You Work, later in this chapter, for 
information on this alert box. 

Print 
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Print Dialog Box Settings 

Print... • Finished Quality 0 Quick Draft (Text Only) 

o One Copy While You Wait • While You Work , ................................................. , 

• All Pages 0 Only "_'",. ; ................................................. ; ". "_", " ; ................................................. ; 

Number of Copies: D00[I][DITJ0ITJ[D§] 

The Print dialog box lets you specify some final details 
about how your document will print. The choices in the 
Pri nt dialog box are discussed below. 

Quality 

Finished Quality: Finished Quality prints your document 
as you have formatted it on the screen, including special 
type styles and fonts. 

Quick Draft: Quick Draft lets you get a printed copy of 
the text faster, but without any special type styles and 
fonts used in your document. On a dot matrix printer, the 
built-in font is used for Quick Draft. On a daisy wheel 
printer, whatever print wheel is on the printer will be 
used, even if you've specified a different one in your 
document. 



Speed 

While You Wait: You can have the Lisa use most of its 
attention to print your document while you wait. A 
document will print more quickly if you choose While You 
Wait, but you won't be able to use your Lisa for any other 
tasks. 

While You Work: You can have the document print while 
you continue to use your Lisa for other tasks. Some 
printing conditions make printing while you work 
inconvenient, however. For example, if you are single 
sheet feeding paper into your printer, and printing a 
Quick Draft, you won't have time to do other activities on 
the Lisa. 

When you choose While You Work, the Monitor the 
Printer dialog box appears. 

Monitor the Printer .. 

Document being printed: The printer is currently inactive. 
(opy being printed: 1 Of 1 
Page being printed: 0 Of 1 

If you want to do other work while the document is being printed, 
click Proceed. Otherwise, just wait. 

If you do decide to Proceed, you can get back here by choosing 
Monitor the Printer from the File/Print menu. You should do that if 
you hear a whistle or if you want to terminate printing. 

( Proceed) 

This dialog box tells you the name of the document, the 
copy, and the page now being printed. Click Proceed to 
return to LisaProject and continue working. Click 
Terminate if you want to stop the printing. If you decide to 
proceed, you can return to this dialog box at any time to 
stop the printing by choosing Monitor the Printer from 
the File/Print menu. 

Note that if you hear a whistle, there is a problem with 
printing while you work. Choose Monitor the Printer from 
the File/Print menu to see what the problem is. 

Print 
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Number of Pages 

All Pages: You can print all pages of a document. Just 
make sure All Pages is checked in the Print dialog box. 

Selective Pages: To print selective pages of a 
document, check Only Pages and then fill in the boxes 
with the starting and ending pages to print. 

When you want to print from the beginning of a 
document through some page number, say 8, you enter 
"8" in the second box after Through. Similarly, if you 
want to start at a given page number and print to the 
end, you need to enter the starting page number in the 
box after Only Pages. 

Number of Copies 

You can print from 1 to 10 copies of any document. Just 
check the box with the number of copies you want 
printed. 
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To copy a chart from LisaProject into the LisaDraw 

~ Get or activate the chart that you want to copy. 

~ Choose Select All of 
Document from the Edit Undo last Change 
menu. 

Cut 
Copy 
Paste 

Select All of Document [:.R 

~ Choose Copy from the Edit menu. 

~ Get or activate the LisaDraw document that you want 
to copy to or tear off a new piece of drawing paper 
and open it. 

~ Choose Paste from the Edit menu. 

Now you can add text and other graphic enhancements 
to your chart with LisaDraw. Note that you have to copy 
each chart into UsaDraw separately. For example, 
copying a Schedule chart into LisaDraw does not copy 
the Resource or Task chart. 
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Appendix 1 
Menu Items 

File/Print Menu 

Set Aside Everything -'---4' 

Set Aside "sjmChl " ..... ---11-' 

Returns all windows to their icons 
without saving the contents. 

Returns the current document to 
its icon without saving the 
contents. 

Saves the contents of the 
document, closes the window, and 
returns the icon to its original 

Save & Put Away location. 

Save & [ont i nue .... ---...... - Saves the contents of the 
Revert to Previous Version document and leaves the window 

open. 

Format For Printer ....... - ............ 
Print ....... -------...... 
Monitor the Printer ... 

Returns the document to its state 
as of the last time you saved it. 

Sets formats in the document 
based on the printer that will be 
used. 

Prints the document. 

Shows the status of the 
document(s) printing. 

Append ix 1 D 1 
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Edit Menu 

4----....... - Restores the document to how it 
Undo Last Change was prior to the last operation. 

Cut 
Copy 
Paste 

_X,} 
~( Indicate basic editing functions. 
IV 

Select All of Document 'A, Selects entire document. 

Type Style Menu 

..... " 

Plain Text" 
Underline 
Bold 

WP 'II Shows standard type font and size. 

Italic 

:~ }-Customize text with underline, 
WI bold or italics. 

15 Pitch Gothic 
12 Pitch Modern 
12 Pitch EI ite 
10 Pitch Modern 
10 Pitch Courier 
PS Modern 
PS Executive 
1/4 Inch Modern 
1/4 Inch Classic 
1/3 Inch Modern 
1/3 Inch Classic 

Indicate type fonts available on 
J----- the Lisa. See Appendix 3, Type 

Fonts, for examples. 



Page Layout Menu 

Display or suppress the display 
1---- of page edges in multi-page 

charts. 

Displays the chart in its actual size, 
ow Actual SiLc ...... ---IIt----- beginning in the upper left corner 

Reduce to 70% of the first page. 

Reduce to Fit Reduces the chart 70%. 

Reduces all pages of the chart to 
fit the document window. Add Page on Right 

Add Page on Bottom 1---- Add a new page to the right or 

Customize Menu 

Aemove Scheduled Dates 
Display Dates ....... -----illt--\ 

Change Task to Milestone 

bottom of the chart. 

Allows entry of the project start 
and end years, working days per 
week, current date, and holidays. 

Allows entry of early/late start and 
early/late finish dates for the 
selected task or milestone. 

Removes scheduled dates 
previously entered for the selected 
task or milestone. 

\ Dispiays dates on tasks and 
milestones in the Schedule chart. 

Allows changes to the Resource 
and Task chart time scale. 

Allows entry of work days 
remaining for a selected task in the 
Resource chart. 

Changes the selected task box to a 
milestone circle. 

Appendix 1 D3 
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Chart Menu 

..... t--------- Displays the Schedule chart. 

Resource o ..... t--------- Displays the Resource chart. 

,.TaclIIIISlllllkl///lllllllll/lllllld ..... t--------- Displays the Task chart. 
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Appendix 2 
Apple Keys 

Some LisaProject menu items contain the Apple key 
symbol followed by a character. 

Menu items that appear with the Apple key symbol can 
be chosen by using the mouse or by pressing the@ key 
and the character associated with that menu item. For 
example, to use the Cut menu item, you first select what 
you want to delete, press the @ key, and while holding it 
down, press the X key. 

The following list shows the characters that can be used 
in combination with the @ key in LisaProject: 

1\ 

" 
B 

C 

P 

U 

V 

X 

Select All of Document 

Bold 

Copy 

Italics 

Plain Text 

Underline 

Paste 

Cut 

Terminate 

Appendix 2 ::: D5 
Apple Keys ••• 



Appendix 3 
Type Fonts 

Type of one size and face is called a font. The "face" is 
the portion of the character that displays and prints. On 
the Type Style menu, some font names are preceded by a 
number that indicates character size. This number 
indicates how many characters will print per inch when 
you use that type font. "PS" in front of a font name 
stands for proportionally spaced. 

The list below shows the fonts as they print. The type 
style of each font is "plain." Each of these fonts also may 
be bold, underlined, and italic. 

You can print any combination of type fonts and styles on 
a dot matrix printer. In order to use them with a daisy 
wheel printer, however, you must have the appropriate 
print wheel for each font. If you choose a font that your 
printer is not set up to use, an alert message is displayed 
on the screen. 
15 PI tch GO"thlC 
12 Pitch Modern 
12 Pitch Elite 
10 Pitch Modern 
10 Pitch Courier 
PS Modern 
PS Executive 

1/4 Inch Modern 
1/ 4 Inch Classic 
1/3 Inch Modern 
1/3 Inch Classic 
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Appendix 4 
Technical Specifications 

Maximum length of any text string: 

50 characters 

Maximum Drawing Size of Schedule Chart: 

96 inches wide by 48 inches long 

Maximum number of tasks to start on anyone day: 

100 tasks 

Maximum number of years in the calendar: 

10 years 

Maximum tasks duration: 

999 days 

Maximum number of holidays: 

20 holidays 

Maximum size of Schedule, Resource, or Task Chart that 
can be pasted into LisaDraw: 

96 inches wide by 48 inches long 
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Appendix 5 
LisaProject Scheduling 

LisaProject is a powerful and flexible interactive 
scheduling tool that permits you to easily add tasks and 
milestones and adjust resource requirements. To permit 
this interactive use, LisaProject uses a scheduling 
algorithm that calculates the earliest possible completion 
of the project except when two or more tasks that are in 
parallel require the same resource. In the cases when 
LisaProject does not calculate the schedule that allows 
you to finish the project at the earliest possible date, you 
can set the scheduled dates to adjust the schedule to 
finish earlier or even at the earliest date. 

In the following example, you will see how the completion 
date changes when LisaProject calculates the schedule 
compared to when you set the scheduled dates. 

~ Open the LisaProject Examples folder. 

~ Tear off a piece of paper from the Construction Work 
stationery pad. 

~ Name the document "Construction Work Example." 

~ Open the document. 

Notice the "Greg" is working on two tasks that are in 
parallel: "Phone Wires Are Run" and "Power and Water 
Installation." "Phone Wires Are Run" has an early 
scheduled start date of 3/11/83, and the project is 
scheduled to be completed on 4/4/83. You are now going 
to remove the early scheduled start date for "Phone 
Wires Are Run." As you will see, the project will then be 
scheduled to be completed on 4/18/83. 

~ Select the task "Phone Wires Are Run." 

~ Choose Set Scheduled Dates from the Customize 
menu. 

~ Press the spacebar to remove the scheduled date. 

~ Click OK. 
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LisaProject has now scheduled the task "Phone Wires 
Are Run" to be performed before "Power and Water 
Installation." "Phone Wires Are Run" is scheduled to be 
completed on 3/15/83, and "Power and Water 
Installation" is scheduled to be completed on 3/31/83. 
The entire project is scheduled to be completed on 
4/18/83. 

The Construction Work Example that you started with 
had been adjusted to finish on 4/4/83 (as early as 
possible) beqause scheduled dates had been set. After 
you removed the scheduled date on "Phone Wires Are 
Run," the entire project is scheduled to be completed on 
4/18/83. With larger and more complex LisaProject 
charts, it becomes more difficult to adjust the schedule 
to get the earliest possible project finish date, but by 
setting scheduled dates properly, you can approach an 
optimum schedule. 

When a Schedule chart has two tasks in parallel that 
require the same resource, LisaProject decides the order 
in which the tasks will be performed by analyzing the 
following information: 

• Scheduled dates for each task. 
• Earliest time that each task can be performed. 
• Task duration for each task. 
• Position of each task in the chart. 

LisaProject attempts to meet all scheduled dates and will 
delay other tasks so that a scheduled date can be 
satisfied. 

It is not always possible for LisaProject to meet all 
scheduled dates. For example, if two parallel tasks that 
required the same resource were given identical 
scheduled start dates, it would be impossible for 
LisaProject to schedule both of the tasks on the same 
date. When scheduled dates cannot be met, the dates on 
the tasks will be underlined, but they will not match the 
scheduled date as it was specified. You may check to see 
if one of your scheduled dates has not been met by 
comparing the dates displayed with the task and dates 
entered in the Set Scheduled Dates dialog box. 
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Index 

A 
Add pages, 856, C60 
Alert boxes, C 18 
Apple keys, 05 
Arrow, 84, C5, C42 

Drawing, 822 
Scroll, C15 

Arrow pointer, C 11 
ASAP, 846, C38 

B 
8ackspace key, 817 
8ars, scroll, C 15 

C 
Calendar 

Creating, 840, C34, 03 
Current date, 842 
Days per week, 841 
Holidays, 842 
Year range, 841 

Caution message, C19 
Chart 

Creating, 84, C23 
Enlarging, 86, 856, C62 
Rearranging, 864 
Reducing, 858 

Chart menu, 04 
Check pointer, C 11 
Clipboard, 812, C48, C49 
Column width control, C15 
Copy, 812, C48, 02 

LisaProject into LisaDraw, 865, C80 
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Create chart, 84, C23 
Critical tasks, 828, C22 
Current date, 842, C7 
Customize menu, 03 
Cut, 860, 862, 02 

D 
Daisy wheel printer, C71 
Date 

ASAP, C38 
Calendar, C34 
Display, 843, C21, C32 
Scheduled, 845, C36 
Work days remaining, 848, C39, D3 

Days per week, 841, C35 
Delete, 860, 862, 02 
Deselect, C13 
Dialog boxes, C 18 
Display dates, 843, C32, D3 
Document, 84, C23 

Creating, 84, C23 
Expanding/reducing, C62, D3 
Retrieving, 840 
Title, 817, C53 

Don't Preview Pages, C73 
Dot matrix printer, C70 
Draw 

Arrows, 822, C42 
Milestones, 861, C44 
Tasks, 88, C45 

Drawing pointer, C 11 
Duration, 818, C51 

E 
Early finish, 844, C21 
Early start, 844, C21 
Edit menu, D2 



Edit 
Copy, C48 
Cut, C49 
Insert object labels, C50 
Insert task duration, C51 
Insert task resources, C52 
Insert titles, C53 
Move, C54 
Revert to Previous Version, C55 
Stretch/shrink objects, C56 
Undo Last Change, C57 

Elevators, C 15 
Enlarge chart, 86, 856, C62 
Enter dates, 839, C31 
Enter text, 816, C47 

F 
File document, 831 
File/Print menu, 01 
Fonts, 07 
Format 

Add pages, C60 
Expand/reduce document, C62 
Specify time scaie, C63 
Specify type style, C64 

Format for Printer, C68, 01 

G 
Get filed document, 840 
Get stationery, 85, C23 

H 
Holidays, 842 
Hourglass, C11 

I 
Icon, C4 
Insertion point, 818 
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K 
Keyboard commands, 05 
Keys 

L 

Apple, 05 
8ackspace, 817 
Tab,817 
Text editing, C47 

Labels, 818, C50 
Large charts, 855 
Late finish, 844, C21 
Late start, 844, C21 
LisaOraw, copy charts to, 865, C80 
LisaProject 

M 

Examples, 873 
Function, 84 
Work flow, C23 

Menu, C16, 01 
Menu bar, C4 
Menu item, C4, 01 
Menu title, C4 
Milestone, 84, C4, C44 

Creating, 861, 03 
Labels, 818, C5 

mm/dd/yy, 840 
Move milestone circles, 87, C54 
Move task boxes, 811, C54 

N 
Note message, C19 

o 
Other tools, LisaOraw, C79 

p 
Page Layout menu, 03 
Page, add/remove, C60 
Paper size, 866 
Paste, 812, 02 
Pointer shapes, C 11 
Preview page, 856, C73, 03 



Print, 830, C74, D1 
Format for specific printers, C68 
Pr"eview a dOGurnent, C73 
Print a document, C74 

Printer configuration, set, C68 
Project finish date, 845 
Project start date, 845 

R 
Rearrange chart, 864 
Reduce chart, 858 
Resource chart, 826, C5 
Resources, 84, 88 

S 
Save calendar, 843 
Save & Put Away, 831 
Schedule chart, 84, C3, C10 
Scheduled dates, 845, C10, D3 
Scroll, 857, C14 
Scroll bars, C 15 
Select, C12, C13 
Shrink, 814, C56 
Slack time, 828, C7 
Stop message, C20 
Stretch, 814, C56 
Su btasks, 859 
Subtitles, 817, C4 

T 
Tab key, 817 
Task boxes, C45 
Task chart, 829, C8 
Task, 84, C4 

Critical, 828 
Duration, 84, 818, C5, C51 
Label, 818, C5 
Resources, 818, C5, C52 

Technical specifications, D9 
Text pointer, 817, C11 
Time line, C6 
Time scale, 827, C63, D3 
Titles, 817, C4, C53 
Type styles, 820, C64, D7 

Type size, 866 
TypeStyle menu, D2 
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U 
Undo Last Change, C57 

V 
View button, 857, C15 

W 
Wait message, C 18 
What-if analysis, 849 
Window, C4 
Work days remaining, 848, C39, D3 

Z 
Zoom, 857 

? message, C20 
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LisaProject Update 
Release 2.0 

Read This First 
Please insert these pages in front of the table of contents of 
your LisaProject manual. 

INTRODUCING THE LISA 2 

New Hardware on the Lisa 2 
As you go through the LisaProject manual, you'll notice a few 
differences between your Lisa 2 and the Lisa shown. Because 
most changes from the Lisa to the Lisa 2 involve new hardware 
and a new Lisa operating system, your owner's guide has been 
completely rewritten. Few changes have been made to 
LisaProject; those changes are described in the next few pages. 

New Icons on the Desktop 
Some of the icons on the desktop of the Lisa have changed since 
the LisaProject manual was written. The table on the next page 
shows the differences between the icons shown in the manual 
and those you see on the Lisa screen. 

For a complete explanation of the functions of the new icons, 
refer to Section B, Desktop Manager Reference Guide, in the 
Lisa 2 Owner's Guide. 



COMPARISON OF LISA ICONS 

Use the table below to identify differences between your Lisa 2 
desktop and the desktop shown in the LisaProject manual. 

Manual 

1-· -I 
ProFile 

m w 
Diskette 

";Pictorial 
Alphabetical 
Chronological 

Straighten up Icons 

2 

Lisa 2/10 

[[3 ] 
Internal Hard DisK 

DiSKette 

.iUU~1;,J'1:0I011l1l11. 

Eject "Diskette" 

v'Pictorial View 

Alphabetical View 

Chronological View 

Straighten up Icons 

Repair "Diskette" 
Erase "Diskette" 

....... ................ ........ ....... " ....... ...... " ........ " ... , ...... 

Empt:9 "w'as h:.'h(~ shet" 

Lisa 2/5 

1-,-

DiSKette 

•• IIU ........ t .... 1 1111 1_ 

Eject "Di skette" 

";Pictorial View 

Alphabetical View 

Chronological View 

Straighten up Icons 

Repair "Diskette" 
Erase "Diskette" 

r"nlptt) "W!Jstcbnsi{ct""" 

LisaProject Update, Release 2.0 



LisaProject Enhancements 

MORE HOLIDAYS 

LisaProject now can accommodate up to 40 specific holidays per 
year. This is twice the number indicated in the LisaProject 
manual. 

CONVERTING BRITISH AND FOREIGN-LANGUAGE MICRO DISKETTES 

You now can use micro diskettes created on British and 
foreign-language Lisa systems. 

When you open a non-US LisaProject document, the system 
recognizes a different format for dates. Consequently, a new 
item on the File/Print menu is available: Data Format (most of 
the time this item will be gray). 

If you want LisaProject to convert the existing date format, 
choose Data Format from the File / Print menu. Mter you do, 
you'll get a dialog box asking, "Change dates to local format?" 
If you click Yes, all the dates are converted to the US format, 
which is mm/dd/yy. 

If you click No, the document retains its original format. Each 
time you open that document, the Data Format item will be 
available, so you will have another opportunity to convert the 
format. 

After you save a converted document, you cannot change back 
to the original format. If you use a converted document with a 
Lisa tool in yet a different language, however, you will be asked 
if you wish to convert the document again. 

Note: You also have the option of converting the format 
temporarily, working with the document, changing back to the 
original format, and saving the document in its original format. 
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Here are two guidelines to remember about conversion: 

1. The format a document had when it was saved determines its 
current format. 

2. A format can always be changed to match the conventions of 
a new LisaProject tool. 

PRINTER FORMATS 

You now can select common metric sizes of printing paper in 
the dialog box that appears when you choose Format for Printer 
from the File/Print menu. 

Also, some printing terminology has changed. You now have a 
choice of High Resolution (better quality but slower) or Low 
Resolution (faster). 
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